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CHAPTER 1
CORRESPONDENCE
1.1 Introduction

Correspondence is the most important channel through which Business Communication and
Official Communication takes place in any written or digital form between two or more parties.
It may be in the form of letters, memos, e-mail messages, text messages, fax messages,
voicemails, notes etc.

Business Executives have to write a large number of letters for various kinds of business
enquiries, purchase orders, money collection, complaints and adjustments and for maintaining
the good relations with other companies. A good business letter follows the 7C’s of
Communication — clarity, completeness, conciseness, consideration, correctness, courtesy and
concentration.

In this unit, the students will learn the different styles of Business Letters and Official Letters
such as Memos, Notices, Office Orders, Demi-Official (DO) Letters and Office Note with
adopting the proper formatting techniques.

1.2 Objectives
After going through this unit, you will be able to:

e Know the meaning of Business Correspondence.

e Define the basic principles of Business Correspondence.

e Make the format and arrangement of Business Letters.

e Use the different styles and layouts of typewriting of letters —Indented, Block and Semi-
Block.

e Know about the Official Correspondence.

e Generate Memos, Notices, DO Letters, Office Orders and Office Notes.

e Identify the three types of Correspondence — Personal, Business and Official.

e Distinguish between Business and Official Correspondence.

1.3 Business Correspondence

Business Correspondence means the exchange of information in any written format inside an
organization (intra-organization i.e. within a business), between two or more organizations
(inter-organization i.e. b2b) and between the customer and organization (i.e. b2c and c2b). E-
correspondence has also become extremely essential for modern businesses.

The whole Business Correspondence should, preferably, be done on the letter-head of the
organization. It is through letters that an organization can build good relations with different



parties i.e. customers, suppliers and service providers. The image of an organization depends on
what impression is conveyed through the business letters. These letters help to bridge the gap
between two parties. Since the basic objective of a business letter is directly or indirectly to
increase the business of the company, it should be drafted and typed with utmost care, accuracy
and displayed in such a way that it gives a pleasing appearance.

Styles of Typewriting Letters

The layout of business letters depends on the choice of individual firm concerned. Yet, some
common styles have been standardized and adopted over the years. The common styles of
business correspondence are:

i.  Indented Style
ii.  Block Style/Fully Blocked Style
iii.  Semi-Block Style

These styles have been discussed as under:
1.3.1 Indented Style

This is the oldest style of typed writing the letters. The word “indented” generally refers to the
beginning of first line of each paragraph by indenting in the left side of the margin of the letter 5
or 7 spaces and typing the remaining lines of each paragraph from the left set margin.

A specimen of the Indented Style of business letter is as under:

GSTNo:............. Telephone No: ........... ...
TinNO: oo e, Mobile No: ..................
E-Mailld: .................... Fax NoOtooooieiiii .

ASHOK ELECTRICAL COMPANY

26 Mount Road
Chennai
Tamil Nadu

Ref. No. AEC/56/Accounts/2076 o August ...

M/s R.K.Khanna & Sons
143, Asaf Ali Road
New Delhi-110002



Subject: Non-payment of dues
Dear Sir,

We regret to point out that we have written to you repeatedly, on 14™ June, 26" June and
again on 10"July, ....requesting to settle the balance account of Rs. 25,000/- (Twenty five
thousand only) against supply of electrical goods vide order No. 36, but we have not received
any response as yet.

In the above circumstances, we are compelled to advise you with great reluctance that
unless our account is settled by 20" July we shall place the matter in the hands of our solicitors.

We trust that you will try to settle our account at the earliest.
Thanking you and hoping to hear from you soon.

Yours faithfully,
for Ashok Electrical Company

(Abhay Prakash)
Accounts Manager

- Block Style/Fully Blocked Style:

This type of letter style is now the most commonly used method of display for all business
correspondence. It is thought to look very businesslike and sleek method. It is also known as the
American Style of typewriting the letters. This layout simply means that every line is aligned
flush with the left margin. No paragraphs are indented, no headings are centered — everything
starts at the left set margin. Paragraphs are separated by leaving two lines blank between the two
paragraphs.

A specimen of the Block Style of business letter is as under:

GSTIN: ... Mobile NO: ..o
E-MailId: ............oo..... Fax No: ...,

ASHOK ELECTRICAL COMPANY

26 Mount Road
Chennai
Tamil Nadu

Ref. No. AEC/56/Accounts/7657



OMAugust,.. ..

M/s R.K.Khanna & Sons
143, Asaf Ali Road
New Delhi-110002

Subject: Non-payment of dues

Dear Sir,

We regret to point out that we have written to you repeatedly, on 14" June, 26" June and again
on 10"July, ....requesting to settle the balance account of Rs. 25,000/~ (Twenty five thousand
only) against supply of electrical goods vide order No. 36, but we have not received any response
as yet.

In the above circumstances, we are compelled to advise you with great reluctance that unless our
account is settled by 20" July we shall place the matter in the hands of our solicitors.

We trust that you will try to settle our account at the earliest.

Thanking you and hoping to hear from you soon.

Yours faithfully,
for Ashok Electrical Company

(Abhay Prakash)
Accounts Manager

1.3.3 Semi- Block Style:

Semi-Block Style is a combination of both the Indented Style and the Block Style. In this style,
there is no indentation in the first line of each paragraph in the body of the letter. All the text of
the paragraph is aligned to the left set margin. All the other parts of the letter are typed more or
less in the same way as in the Indented Style. It gives a neat and balanced look to the letter,
which is more popular. Paragraphs are separated by a double or a triple spacing.

A specimen of the Semi-Block Style of business letter is as under:

GSTNO: .o, Telephone No: .................
TiNNO: ..., Mobile No: ..........coeeuite.



E-Mail Id: .................... Fax NO: ..o,

ASHOK ELECTRICAL COMPANY

26 Mount Road
Chennai
Tamil Nadu

Ref. No.AEC/56/Accounts/8765 9MAugust, ....

Messrs R.K. Khanna & Sons
143, Asaf Ali Road
New Delhi-110002

Subject: Non-payment of dues

Dear Sir,

We regret to point out that we have written to you repeatedly, on 14" June, 26" June and again
on 10"MJuly, ....requesting to settle the balance account of Rs. 25,000/- (Twenty five thousand
only) against supply of electrical goods vide order No. 36, but we have not received any response
as yet.

In the above circumstances, we are compelled to advise you with great reluctance that unless our
account is settled by 20" July we shall place the matter in the hands of our solicitors.

We trust that you will try to settle our account at the earliest.

Thanking you and hoping to hear from you soon.

Yours faithfully,
for Ashok Electrical Company

(Abhay Prakash)
Accounts Manager

1.4 Official Correspondence
Official Correspondence define official work letter and include all action of work in an office.

The letters are written between different offices and departments of government, autonomous
bodies and government and semi-government bodies. It includes the letters written between two
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governments, inter-government, from one state government to another state government or the
central government or vice versa. Like business letters — the official letters are not friendly.
There is no personal touch. These letters are formal letters and demand special care of dignity
and designation of the person or officer writing the letter. The letter heading in an official letter
is mostly followed by the words ‘From’ and the addressee’s name and address is followed by the
words ‘To’. They have different layouts, styles, language etc. These letters have to be a fine
blend of clarity, correctness and conciseness in all aspects.

Types of Official Correspondence

Various types of Official Correspondence are given below:
1. Official Letters

2. Demi-Official letters (D.O. Letters)
3. Office Memorandum (Memo)

4. Office Order

5. Unofficial Note (UO Note)
6.Circular Letters

7. Endorsements

8. Notifications

9. Resolutions

10.Press Communiqué (Press Release)

All these types of Official Correspondence are discussed below:
1.4.1 Office Memorandum:

The Office Memorandum is known as ‘Memo’ and is commonly used for interoffice
correspondence in different offices. A memo is a message in writing sent by one person or
department to another ‘within the same organization’. This is the reason why a memo sometimes
is described as an inter-office memo. It is usually used in offices for routine matters like
granting of annual increments, confirmation in services, making announcements, requests, policy
statements, notices, reminders, suggestions, acknowledgements, congratulations, informal
invitations, salary and leave adjustments etc.

It is usually drafted by Senior Officers for their subordinates. It includes the name of the
originator, the intended person(s) to whom it is addressed, the date of issue, the general topic and
the body of the document.

The important features of the memorandum are:
(i) It is written in third person;
(i) It is written in direct style;

(iii) It does not have either salutation or subscription;



(iv) The address of the addressee is written in the left hand bottom corner after the signature;
(v) It contains either the name or the designation of the officer signing the letter.

A specimen of the memorandum is as under:

Name and Address of the Department
Memo No.& Dated

MEMORANDUM

Subject: Appointment to the Post of Lower Division Clerk

With reference to her application dated........... for the Post of Lower Division Clerk in the
Administrative Department, Ms. Urvashi Rana is selected for the same post and is requested to
join with immediate effect.

ADMINISTRATIVE OFFICER

Ms. Urvashi Rana
B-38, Uttam Nagar
New Delhi-110059

1.4.2 Office Order

According to rules Office Orders are used by a competent authority for issuing instructions for
internal administration like change of working hours, warning letter, show cause notice, grant of
leave, distribution of work, promotions and transfers etc. They are the means of downward
communication. The Office Orders are issued periodically. The sequence of information is pre-
decided. The copy of the Officer Order is also forwarded to the other effected
Departments/Officers. It is also written in third person.




A specimen of the Office Order is as under:

Name and Address of the Department

OFFICE ORDER

Mr. Sumit Kumar, Assistant, Administrative Section has been transferred to the Accounts
Section with immediate effect. He is also directed to join at the earliest and hand over the charge
of his duties to Mr. Rakesh Sharma, Accounts Section.

ADMINISTRATIVE OFFICER
Copy to:

1. The Section Officer, Accounts Section

2. The Section Officer, Administrative Section

3. Mr. Rakesh Sharma, Assistant, Accounts Section

4. Mr. Sumit Kumar, Assistant, Administrative Section
5. Personal files of the concerned persons

1.4.3 Demi-Official Letter (DO Letter):

The DO letters are generally written or typed in the form of personal or private communication
on the printed personal letter heads containing personal name, official designation, name and
address of the office etc. These types of letters are written by one official to another for various
reasons such as (i) maintenance of secrecy (ii) drawing personal attention (iii) expecting quick
decision on the matter etc.

Some of the features of DO letter are as under:

DO letter is written in first person using “I”” instead of “We” in a friendly way;

It is addressed personally to an officer by his/her name;

The reference No. and Date are written as usual as “DO No........ ”

Subject is not mentioned in the DO letter;

The starting point of D.O. letter is ‘Dear Mr.......... > or ‘My dear Sh.............. > In

appropriate salutation;

6. The name of the officer writing the letter and his designation are written before the
salutation at the left hand margin;

7. The subscription or complimentary close often used in DO letters is “Yours sincerely’
or ‘Sincerely yourS’ or ‘Sincerely’.

8. It is signed by the officer without stating his designation at the bottom as the same is

written on the letter-head. Only the name is written within brackets.

ARSI




9. Inthese letters, the name and letters of the addressee is written at the end on left hand
bottom corner of letter after the signature line.

10. The respectful phrases like “With kind regards”, “With best regards” etc. may be
added before the complimentary close.

A specimen of the Demi-Official (DO) letter is as under:

Name and Address of the Department

Mr. Dinesh Sharma
Purchase Officer

D.O.No............... Dated: ..........ceevene.

Dear Shri Gupta,

Please refer to your letter No........... dated........... regarding the purchasing of stationery items
from the “Vikas Publications”. I shall be glad if you kindly let me have your comments on it,
which you had discussed in your purchase committee meeting. The minutes of the same
committee may also be forwarded to me, if possible. It is proposed that we can convene an
Inter-departmental meeting during the next week to finalize the rules and regulations for the

purchase of stationery items. Hence an early reply will be appreciated.

With warm regards,

Yours sincerely,

(Dinesh Sharma)

Mr. Rakesh Gupta

Convener
Purchase Committee

1.4.4 Office Note:

It is also known as Inter-departmental Note or Un-official Note. Office Note is used for a
horizontal communication. They are exchanged between departments, or between officers of




almost equal rank. These notes are circulated asking for suggestions, advice, views and
comments of other departments on a proposal or in seeking or giving information about some
matter concerning their respective departments. This reference can be made either on the note
itself, or by an independent self-explanatory note. No salutation or complimentary closes are
required.

Office Notes usually Follow the Memo Format.

DEPARTMENT OF COMMERCE

The Head of the Department of Commerce has desired to obtain the observations of all the
Heads/Teacher-in-charges of the Colleges under the Commerce Department, on the enclosed
letter regarding the change of syllabus under the CBCS Programme.

The observations/comments may kindly be submitted as early as possible.

( )

Programme Coordinator

All Head/Teacher-in-Charges

Encl: As above

15 Review Questions:
1. What do you mean by Correspondence?
2. What do you mean by Business Correspondence?
3. What is the difference between Business Correspondence and Official Correspondence?
4. How many styles are implemented for Business Correspondence? Explain.
5. Explain the difference between Semi-Block and Fully Blocked Style.
6. Explain the difference between Indented and Semi-Block Style.
7. Define the different types of Official Correspondence.

8. Write down the features of Demi-Official (DO) Letters.
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9. What is the difference between a Memorandum and an Office Note?

10. Write down the features of an Office Order.

11. What is the difference between Formal and Informal Letters?

Fill in the Blanks:

(1)
(i)
(iii)

(iv)
(V)
(vi)
(vii)
(viii)
(ix)
(x)

The memorandum is always written in person.

A good business letter follows the 7C’s

The paragraphs are indented in the left margin in Style letter.

No paragraphs are indented, no headings are centered in

Style of letter is called the American Style of typing letter.

The letters are not friendly.

The subject is not written in letter.

The memos are called

No salutation and complimentary close are required in
Office Note is used for communication.

The complimentary close such as ‘sincerely yours’ is used in

11
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CHAPTER 2
MANUSCRIPT
2.1 Introduction

A manuscript is any document in typewritten or hand-written form — it may be books, legal
documents, letters, e-mails, articles in magazines, thesis, project reports, agenda, minutes,
documents, agreements, dissertations and research papers which are corrected before sending to
the publisher for its publication. These documents are considered as drafts or rough scripts.

These drafts require many additions, deletions, alterations, and modifications before sending the
same to the publisher. The drafts are read again and again and the requisite proof correction
signs are put to make corrections in the margins of the document. These symbols are called
Proof Correction Signs.

2.2  Objectives
After going through this unit, you will be able to:

e Know the meaning of Manuscript.

e Learn the different proof correction signs.

e Typewrite the fair copy of the documents by incorporating necessary corrections.
e Know the procedure to finalize the documents from Manuscripts.

e Take precautions while typewriting from Manuscripts.

2.3 Meaning

Manuscripts are rough scripts - hand-written or printed, in any form, having corrections,
additions, deletions, alterations or modifications etc. In certain cases, the Manuscripts are half-
typed and half-handwritten. The various changes i.e. additions, alterations, and corrections are
indicated on the Manuscripts by Standard Proof Correction Signs. Manuscripts also form part of
question papers set for most of the typewriting examinations. The Office Assistants/Computer
Operators are required to typewrite Manuscripts written by various persons. In order to become
an efficient Office Assistant or Computer Operator, he should attain mastery in typewriting of
Manuscripts of different kinds and should have the thorough knowledge about the standard Proof
Correction Signs.

2.3.1 Proof Correction Signs/Symbols

12



The Standard Proof Correction Signs are given below:

Proof Correction Signs/Symbols

Symbol/Sign | Meaning Before Correction After Correction
Caps (Capital) The meeting ended with a The meeting ended with
Change the alphabets | vote of thanks to the )Zﬁair. a vote of thanks to the
underlined/ crossed Chair.
through to Capital
Letters.
The meeting ended with a The meeting ended with
( Space) votepfthanks to the Chair. | a vote of thanks to the
# Insert the Space. Chair.
The meeting ended  with The meeting ended with
a vote / of thafks to the a vote of thanks to the
Chair. Chair.
Eq# Equalize Spacing.

l.c./s.c

(Lower case/small
case)

Change the alphabets
underlined/crossed
through the lower
case/small case).

The Committee Members
are selected according to
their Seniority.

The Committee
members are selected
according to their
seniority.

NP or
/!

(New Paragraph).

The Board shall issue
certificates of registration to
each member of the
Shorthand Reporters
Association with five years
of reporting experience.

The Board shall conduct
such examinations annually
and at such times and places
as it may deem necessary.
/IAll “applicants’ for
registration shall be given at
least sixty days notice of the
examination to be conducted
by the Board.

The Board shall issue
certificates of
registration to each
member of the
Shorthand Reporters
Association with five
years of reporting
experience. The Board
shall conduct such
examinations annually
and at such times and
places as it may deem
necessary.

All “applicants’ for
registration shall be
given at least sixty days
notice of the
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examination to be
conducted by the Board.

(Run on)
There should be no
paragraph.

The hardware and software
are likely to become less
expensive as technologies
become sophisticated.

2, Their installation being
possible in remote areas has
increased their popularity.

The hardware and
software are likely to
become less expensive
as technologies become
sophisticated. Their
installation being
possible in remote areas
has increased their
popularity.

(Delete the matter)
Not required to Print.

The Heading of the letter
should rot be centralized.

The Heading of the letter
should be centralized.

orD
Ctr. (Centralized the Delhi Development Delhi Development
matter). Authority. Authority.
stet (let it stand as it is) The Board may prove that The Board may prove
Do not delete the the applicant has the that the applicant has the
matter. Ignore the knowledge, practical knowledge, practical
corrections dotted experience, and competence | experience, and
underneath/underlined. | necessarytoact as—a competence necessary to
Shorthand Reporter and may | act as a Shorthand
require a practical Reporter and may
demonstration of the require a practical
applicant’s skill. demonstration of the
applicant’s skill.
In full (Write the matter in The Committee decided to | The Committee decided

full form instead of
short form).

complete the work within a
month conducting the
meetings on every
Wednesday i.e.
3rdAugust,....... and.....

to complete the work
within a month
conducting the meetings
on every Wednesday i.e.
31, 10™, 17", 24" and
31t August.

Trans

(Transpose the words).

| believe the education is
spreading undoubtedly.
Possibly infew alyears’
time, perhaps four or five
years, it may well include
everybody and girl in the
country.

| believe the education is
spreading undoubtedly.
Possibly in a few years’
time, perhaps four or
five years, it may well
include everybody and
girl in the country.
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(Transpose the letters).

| believe the edg{ption is

| believe the education is

spreadﬂq,b undoubtedly. spreading undoubtedly

Trans

Trans (Transpose the words | I believe the education is | believe the education is
given in a jumbled spreading undoubtedly. spreading undoubtedly.
order). Possibly in a few years’ Possibly in a few years’

time, perhaps years five or | time, perhaps four or

four, it five years, it may well
@ @ @ @ include everybody.

may well include

everybody.

SP (Spell) The Board decided to except | The Board decided to
Correct the spelling the Ministry’s invitation in | accept the Ministry’s
error. principal. invitation in principle.

C (Close Up) Now, the reasons why girls” | Now, the reasons why

Not to leave any space
between the two

educgtion has lagged behind
some_what are fairly

girls’ education has
lagged behind somewhat

words. obvious social customs. are fairly obvious social
customs.
(Doubtful/Query and The minutes of the

make it clear from the
author or writer).

The minutes of the meeting
held .@
were discussed and

confirmed.

meeting held on August
10, ... were discussed
and confirmed.

(Change to correct
font).

The minutes of the meeting
held on

were discussed and

The minutes of the
meeting held on August
17 were discussed and

confirmed. confirmed

Move to the Left. | believe the | believe the education is
education is spreading spreading undoubtedly.
undoubtedly.

Move to the right.

| believe the education is
_spreading undoubtedly.

| believe the education
is
spreading undoubtedly .

Move up. The minutes of the meeting | The minutes of the
| | held on August102016 Were meeting held on August
discussed and confirmed. 10, ....were discussed
and confirmed.
The minutes of the meeting | The minutes of the
| Move Down. held on August 10, 2016 \yere meeting held on August

discussed and confirmed.

10, 2016 were discussed
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and confirmed.

Straighten the left
Margin.

he Board may prove
hat the applicant has the
nowledge, practical
experience, and competence
necessary to act as a
Shorthand Reporter.

The Board may prove
that the applicant has the
knowledge, practical
experience, and
competence necessary to
act as a Shorthand
Reporter.

Justify the matter
(Right Side).

The Board may prove that
the applicant has the
knowledge, practical
experience, and competence
necessary to act as a
Shorthand Reporter.

The Board may prove
that the applicant has the
knowledge, practical
experience, and
competence necessary to
act as a Shorthand
Reporter.

Insert Full Stop.

The hardware and software
are likely to become less
expensive as technologies
become sophisticated/ Their
installation being possible in
remote areas has increased
their popularity/.

The hardware and
software are likely to
become less expensive
as technologies become
sophisticated. Their
installation being
possible in remote areas
has increased their
popularity.

Insert Comma.

The Board may prove that
the applicant has the
knowledge/ practical
experience/ and competence
necessary to act as a
Shorthand Reporter.

The Board may prove
that the applicant has the
knowledge, practical
experience, and
competence necessary to
act as a Shorthand
Reporter.

Insert sign of
Interrogation.

What should you do when
you decide that a meeting is
necessary/.

What should you do
when you decide that a
meeting is necessary?

Insert Hyphen.

Make sure you undersand
the question / paraphrase it
if necessary; repeat it if
needed.

Make sure you
undersand the question-
paraphrase it if
necessary; repeat it if
needed

Insert Dash.

Here are three samples of

Here are three samples
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visuals commonly used for
presentations / a pie chart, a
table and a bar garph.

of visuals commonly
used for presentations --
a pie chart, a table and a
bar garph

Insert Sign of
Exclamation.

Wow / This grammar stuff
is interesting.

Wow! This grammar
stuff is interesting.

/

Insert Semi-colon.

I will be there as soon as |
finish working / that is a
promise | will definitely
keep.

I will be there as soon as
I finish working; that is a
promise | will definitely

keep.

/A

Insert Colon.

This is the reason why a
memo is sometimes also
described as an inter-office
memo/ a message sent from
one office to another

This is the reason why a
memo is sometimes also
described as an inter-
office memo: a message
sent from one office to
another

I/

Insert sign of
Apostrophe.

I/ m afraid it won/t be
possible.

I’m afraid it won’t be
possible.

I

Insert double inverted
commas.

/The delegation is expected
to arrive next week./

“The delegation is
expected to arrive next
week.”

/o

Insert

Insert the matter in the
Margin.

The next meeting of
A16/8/  Purchase
Committe

2016  Will be he held on
Tuesday " at 9.30 am.

The next meeting of the
Purchase Committee
will be held on Tuesday,
16/8/2016 at 9.30 a.m.

2.4 Procedure of Preparing a Fair Copy of the Manuscript

For Typewriting a fair copy of a Manuscript, the Office Assistant/Computer Operator/
Stenographer/Personal Assistant should possess sound knowledge of the language in which the
document has been written. He may face certain difficulties at the time of preparing a fair copy
of the Manuscript such as the problem in understanding the handwriting of the person who has
written the Manuscript, spellings of certain difficult words, and so on. Hence he should be well
acquainted with the various Proof Correction Signs, their meaning and usage. He should be well
aware about the various rules of display to be applied in different kinds of documents, especially
when the documents are in draft form and are sometime hand written with various corrections
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indicated by the standard proof correction signs. The following points should be kept in mind at
the time of typewriting the fair copy from the Manuscripts:

2.5

Before starting to typewrite the document, it should be read once or twice. In case the
document is lengthy one, it should be read paragraph wise. By reading the document
once or twice, he becomes familiar with the style of the person who has written the
document and it becomes easy to typewrite a fair copy of the Manuscript.

The word which is not clear in the Manuscript should be encircled and he should proceed
reading the matter. It may be possible that this word is more clear in the following
paragraphs of the document.

In case, after reading the whole document, one is not able to understand any word, the
sentence should be read time and again in order to find out the correct word which
conveys the correct sense of the sentence.

During the course of typewriting from the Manuscripts, the spellings of the words must
be checked with the help of Dictionary in the Computer. The Computer Operator should
run the Spelling Check and Grammar Check after typewriting the whole document before
giving the print command.

No sentence should be typed by a mere guess work.

The Operator should apply common sense while typewriting from Manuscripts and
glaring errors should be avoided.

Most commonly used abbreviations should not be typed in full. For example, ‘Dr.’
should not be typed ‘Doctor’, ‘Mr.” should not be typed as ‘Mister’ and so on.

The whole document should be compared with the Manuscript before giving the print
command.

Review Questions

What is Manuscript?
What is proof-reading?
What is the difference between proof-reading and manuscript?

What should we do before typewriting the manuscript?
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5. Why do we need to learn the manuscript signs?
6. Is it compulsory to read the passage two or three times before final typing?

7. Explain the meaning of the following Proof Correction Signs:

1. Stet
2. Trans
3. Cap
4. I

5. /7

10. D

19



Specimen of Manuscripts

A few specimens of typed and hand written Manuscripts are given below:

Specimen 1
Typewrite a fair copy of the following Manuscript on your Computer by incorporating the

corrections:

/‘{t..é'/

.'f/zs_/ of

Tabulaticn is usually the mest—difficult-work
mtypist may be called upon to execute/ It
is somewhat slower than ordinary typing work, High

speed in this kind of work is ,( not expected., Accuracy

is the first and chief consideration. /4abu1ation work
easy very bec‘qmes whenfare kept in mind - patiencey @
commonsense and correct arithmptégl:p g

C With these at command, the ty)Jst will find that /1"

tabulation work is very eas}l and it is surprising how

quickly etlen 3 difficult piece of work can be }{ounted;

and typed.
. N
Tabulation is the orderly, columnar arrange ment

of wofds, ‘figures, amounts and the like in tables.

On depressing the tabular bar the carriage moves

and /swi ftly)quickly and stops only at those points

wihere tabulztor stops have been seyThe tabular bar
1 >

is. a time saving device, now available on almost al
“This set.ting!is done with the help of

typewriters,

ta‘bul'atot set key.
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Specimen 2

Typewrite a fair copy of the following Manuscript on your Computer by incorporating the
corrections:

The whole position is, as it was very recently
/, remarked/ that loblying is being carried out in
7 ﬁhis 9fountry in favour of China. ¥Those of us who
//‘t.t qine th:gugh ha.ve the voluminous dets—hes—teen—suppiied

+o the House snd to us have found that, even though

/C‘,{ /ﬁ»‘ . the l{ovem::ent and the Prime .'.unist.erw

/J that we will not give away / 2ny portion of our

" territory, .
[ e ._/'/’)
: when it comes to the guestion of making 2

t) ~
citcgorica.l statement in the louse — I d o not know
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Specimen 3

Typewrite a fair copy of the following Manuscript on your Computer by incorporating the
corrections:
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Specimen 4

Typewrite a fair copy of the following Manuscript on your Computer by incorporating the
corrections:
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Specimen 5
Typewrite a fair copy of the following Manuscript on your Computer by incorporating the

corrections:
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CHAPTER 3
EXCEL
3.1 Introduction

MS- Excel 2007 is a windows based application package. It provides powerful tools and features
that can be used to analyze, share, and manage your data with ease. It displays a table of numbers
and text in rows and columns, and used for accounting, budgeting, financial analysis, scientific
applications, and other work with figures. It performs detailed analysis on numerical data. The
analysis is done by defining formulas to perform calculations on a set of data, link different
worksheets and present data in the form of graphs. It automatically recalculates the result of
mathematical formulas if the source data changes.

An Excel file is made up of Worksheets, which collectively are called a Workbook. Worksheets
are pages within a workbook and can contain data or be blank. Worksheets can contain
information and work independently of each other or can be linked together to form a workbook.
Each worksheet contains horizontal rows and vertical columns. The maximum number of rows is
18,278 (A to ZZZ) columns and 1,048,576 rows. The intersection of a row and column is a cell.

3.2 Objectives

After going through this lesson you would be in a position to

Explain the basic features of MS Excel.
Set pages and their printing.

Modify a worksheet.

Enter and edit data in a worksheet.

Use formulas and functions.

Format data and worksheets.

Use AutoFormat and AutoCorrect features.
Prepare chart from data.

3.3 Starting Excel

1. Click on (with the help of mouse) the Start button on the Windows 7 Taskbar at the
bottom of the Screen.

2. Highlight the All Programs item. The menu will open.
3. Select Microsoft Excel from the list of programs.
4. Click on Microsoft Excel

Select Start->All Programs->Microsoft Office->Microsoft Excel commands from menu bar.
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é ?:ti?l;gf;yplnrer @ Set Program Access and Defaults
L E-mail

z %% windows Catalog
1N
L3V Microsoft OFfice Outl

% windows Update

i) Accessories

) Games

i) innotek VirtualBox Guest Additions

L’g Microsoft Office Wor

‘d Paint
fE Microsoft Office

v MSH i) startup

& Internet Explorer B Microsoft
@ windows Media Play

L | i ffice Outlook 20e

b i I - Micrasoftioffice outicok2 Perform calculations, analyze informa

S ; [5) Outlook Express (i3 Microsoft OFfice PowerPoinlin spreadsheets by using Microsoft O
P windows Messenger

Remote Assistance [ Microsoft Office Publisher 2007

[iw Microsoft Office Word 2007

i) Microsoft OFfice Tools >
P= Microsoft Office Access 2007

vEMY v v

-
’_X_E Microsoft Office Exce & Windows Media Player
3 windows Messenger

All Programs B SR wWindows Movie Maker
@] Log Off ‘® l Turn OFf Computer

The symbol - is used to indicate the direction (steps) to be followed in all the chapters of MS
Excel.

Microsoft Office Shortcut Bar can also be used to start work on Excel.
3.3.1 Excel Window

Excel window has ribbon, name box, formula bar, worksheet, scroll bars, Status bar, Sheet tabs,
buttons like Normal View, Page Layout View, Page Break Preview.

(uick Access Toolbar

Tabs (Home fab is currently active) Dialog box launcher

=~ -0 oki
F@ =
Home | liset  Pagelsyout  Formulas  Data  Review  View

‘ I L Sl | =
Ribbort | ﬁ i Calibri S AN | ¥ EF | Genent - : 127 :A:;::‘, 5. gr \ﬁ

| | . A ! e = z 1 £

lpte O lim oz u-E-a- A EEBEE S (so% o wa e s - St | [Edromat - | 22~ PR LR

fictobong = oty = ARgROL & Number _(5F Cetis Editing

bl 2 / A

Sheet Tabs

W 4 » ¥ Sheetl . Sheet2  Sheet3  ¥3

Status Bar -
\
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3.3.2 Excel Ribbon

Office button
Quick Access
Toolbar Command button
Tah
(] s I - — S
"r‘f f Jritet Fage Lk Farwias Dt Eofret o -.'.".-'.I W i
b lom i K (] [ o SRR E e
P B R L T I R e T TN S O e LY

= R

Group Dialog box launcher

The band at the top of the Excel 2007 window is the Ribbon.

1. Office button: The button is used to open, save and print the document. Option available are
New, Open, Save, Save as, Print, Prepare, Send, Publish, Close.

2. Quick Access Toolbar: Save, Undo, redo, and the toolbar is completely customizable.
3. Tabs: Home, Insert, Page Layout, Formulas, Data, Review, View.
4. Group: Each tab has a number of groups. Groups have number of options.

5. Dialog box launcher.

3.3.3 Excel Workbook and Worksheet

An Excel workbook is a file that contains one or more worksheets that can be used to organize
related information. Each new workbook comes with three worksheets, like pages in a document.
Each workbook can contain upto 255 worksheets. Data is entered into the worksheets. Each
worksheet has a name on its sheet tab at the bottom left of the workbook window: Sheetl,
Sheet2, and Sheet3. Click each sheet tab to view a worksheet.

3.3.4 Opening Workbook
{ Dn
1. Click Microsoft Office Button " * , and then click New.

2. Under Templates, select Blank and recent and under Blank and recent in the right pane,
click Blank Workbook.

3. Click Create.
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3.3.5 Data Entry
Various kinds of data can be entered in a cell.

1. Numbers: Numbers are from the entire range of numeric values: whole numbers (example
25), decimals (example, 25.67) and scientific notation (example,0.2567E+2). Excel displays
scientific notation automatically if a number is entered that is too long to be viewed in its
entirety in a cell. Number signs (# # # # # #) can be seen when a cell entry is too long.
Widening the column will allow to read the number.

2. Text: Select the cell in which data has to be entered and type the text. Press ENTER key to
finish text entry. The text is displayed in the active cell as well as in the Formula bar. If
numbers are to be treated as text use an apostrophe (“) as the first character. Calculations
cannot be done with these kind of data entry.

3. Date and Time: When dates and times are entered in a cell, Excel converts these entries into
serial numbers and kept as background information. However, the dates and times will
be displayed on the worksheet in a format selected.

4. Data in Series: Fill a range of cells either with the same value or with a series of values with
the help of AutoFill.

3.3.6 Navigating the Worksheet

One can advance through worksheet by rows with the vertical scrollbar or by columns with the
horizontal scrollbar. When the thumb tab on the scrollbar is clicked and dragged, a Screen Tip
will appear alongside the bar identifying the row or column to which the view is advancing.
keyboard shortcuts can also be used for navigating the worksheet.

Page Setup

Select Page Layout tab—>Page Setup group to format the page, set margins, and add
headers and footers.

BN RS

Margins Crientation  Size Print Eackground Print
G G £ Area - Titles
Page Setup F

1. Margins: Change the top, bottom, left, and right margins under the Margins.

2. Orientation: To select the orientation of the page Landscape or Portrait.
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3. Size: Set the paper size to be printed.

3.3.7 Saving and Printing the Workbook

[ O
Click Microsoft Office Button | and then click Save As—>type file name and press Save. For
printing select Print—=>Print

3.4 Editing Excel
3.4.1 Selecting Cells and Ranges

To enter data into worksheet first a cell or range is to be selected. When an Excel worksheet is
open, cell Al is already active. An active cell will appear to have a darker border around it than
other cells on the worksheet. The simplest way to select a cell is with mouse pointer. Move the
mouse to the desired cell and click on it with right button. Whatever is typed goes into the cell.
To select a range of cells, click on one cell, hold down the left mouse button and drag the mouse
pointer to the last cell of the range that is to be selected.

Selecting Cells

A cell must be selected first, before it is modified or formatted. Refer to the table below for
selecting groups of cells.

Cells to Select Mouse Action

Single Cell Click once in the cell.

Entire Row Click the row label.

Entire Column Click the column label.

Entire Worksheet Click the whole sheet button (at the intersection of

rows and columns).

Cluster of Cells Drag mouse over the cells or hold down the SHIFT
key while using the arrow keys.

To activate the contents of a cell, double-click on the cell or click once and press F2.
3.4.2 Editing Data
Data can be edited by any of the following ways:

1. Select the cell containing data to be edited. Press F2. Use Backspace key and erase
the wrong entry. Retype the correct entry.

2. Select the cell and simply retype the correct entry.
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3. If the contents of the cell is to be cleared, select the cell and press Delete key.

4. To get back the previous entry, either click on Undo button on standard Toolbar or
select Edit->Undo command or use keyboard shortcuts CTRL+Z.

3.4.3 Modifying a Worksheet
3.4.3.1 Adding Worksheets, Rows, and Columns.

1. Worksheets: Add a worksheet to a workbook by selecting Home tab—>Cells group Click
Insert-> Insert Worksheet.

2. Row: To add a row to a worksheet, select Home tab—>Cells group Click Insert-> Insert
Sheet Rows.

3. Column: Add a column by selecting Home tab—>Cells group Click Insert-> Insert Sheet
Columns.

3.4.3.2 Resizing Rows and Columns
The two methods to resize rows and columns are :

1. Resize a row by dragging the line below the label of the row to be resized.
Resize a column in a similar manner by dragging the line to the right of the label

corresponding to the column to be resized.

2. Click the row or column label and select Home tab—>Cells group Click Format->Row
Height or select Home tab-> Cells group Click Format->Column Width

3.4.3.3 Moving and Copying Cells, Freezing pane
1. Moving Cells

To move the cell contents to another cell select Home tab—> Clipboard group-> Cut. Highlight the
cell to paste select Home tab—>Clipboard group—>Paste.

2. Copying Cells

To copy the cell contents, select Home tab—>Clipboard group—>Copy. Highlight the cell to paste
select Home tab—>Clipboard group—> Paste.

3. Drag and Drop

To move the cell contents only a short distance, the drag-and-drop method is used. Drag the
highlighted border of the selected cell to the destination cell with the mouse.
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4. Freeze panes to lock specific rows or columns
On the worksheet, perform one of the following

e To lock both rows and columns, click the cell below and to the right of where the split
has to appear.

e To lock rows, select the row below where the split is to be appeared.
e To lock columns, select the column to the right of where the split is to be
appeared.

On the View tab, in the Window group, click Freeze Panes, and then option.

g New Window [+ split %
= Arrange — Hide fld
L Save Switch

- - . an
I Freeze Panes Workspace Windows =

Window

When one freeze panes, the Freeze Panes option changes to Unfreeze Panes so that one can
unlock frozen rows or columns.

3.4.3.4 Find and Replace Data, Autofill

To locate a number or text that is already typed in the worksheet, select Home tab->Editing
group click Find & Select Option—>find.

Data can also be located and replaced with new data with Home tab->Editing group Click Find
& Select option—>Replace.

Find and Replace @E|
Find Replace
Find what: Item w
Replace with: | MewItem w
I Replace Al J [ Replace l [ Find all ] [ Find Mesxk l [ Close ]
Autofill

Autofill is used to fill automatically ie., fill a series of numbers, numbers and text combinations,
dates or time periods, based on the pattern established. Select cells and drag the fill handle
—1
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3.5 Formatting Worksheets
3.5.1 Formatting Cells

Select Home tab—> Alignment group. Format Cells dialog box opens.

Alignment Font Border | Patterns | Protection
Sample
Mumber
Currency
Accounting eneral format cells have no
Dake specific number Format,
Time
Percentage
Fraction
Scientific
Text
Special
Cuskam
Ck l [ Cancel
Number Tab

The data type can be selected from the options on this tab. Select the range and click on one of
the Category, apply that style to numbers.

e Select General if the cell contains text and number and it does not have any specific
number format.

e If Number Category is selected numbers can be represented as integers, decimals with
number of decimal as option etc.

e Date and Time: Used to change the date format and the time format.

Alignment Tab

These options allow to change the position and alignment of the data with the cell. The tab gives
text alignment options.

Font Tab

All the font attributes are displayed in this tab including font face, size, style, and effects. The
Format Cells dialog box offers options bold, italicize, and underline for cell entries.
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Border Tab

In the Format Cells dialog box, in Border option the size and style of the border can be changed.

3.5.2 Formatting Rows and Columns

For formatting columns and rows AutoFit Selection feature can also be used. It adjusts a column
width or a row height according to the widest entry of a column or tallest height of a row. Select
Home tab—>Cells group, click Format->AutoFit Row Height or AutoFit Column Width. It
adjusts the width of the column according to the widest entry in that column and increases the
height of the row(s) to accommodate the tallest character in a row.

Hide

Hides the selected column(s) or row(s), though the data is still there. Hiding column(s) or row(s)
will help to prevent unwanted changes. To hide a column:

1. Select the column to hide by clicking on the column header.

2. Select Home tab—>Cells group, click Format—> Visibility=>Hide & Unhide option. Select any
of the three options Hide Rows, Hide Columns and Hide Sheet.

AT A
Sont& Find &
Filter» Select~

Sealnsert ~
General - &, 2
s By 4] - 4 =
5 S || sk perete -
$ - % | %3 %Il conditional Format Cell ||gm -

|| Formatting = as Table ~ Styles - || [c5) Format =

Number i Styles Cell Size

[N IR

H 1 ] K L

Unhide
To unhide the column:
1. Select the visible range of columns that includes the hidden column(s).

2. Select Home tab—>Cells group, click Format—> Visibility=>Hide & Unhide option. Select any
of the three options Unhide Rows, Unhide Columns and Unhide Sheet.
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3.5.3 Formatting Text

Formatted text has control codes indicating the fonts, bold or italic type, margins, indents,
columns, tabs, headers and footers, and other attributes.

1. Merge & Center: Select the cells. On the Ribbon, select the Home tab = in the Alignment
group - click Merge & Center. All selected cells are now merged and the data in the first cell is
centered. To unmerge the cells simply follow the same process.

2. Basic Style Changes: On the Ribbon, select the Home tab = in the Font group -
select B for Bold, | for italics, U for Underline.

3. Background Colour : Select the cells. On the Ribbon, select the Home tab - in the Font
group—>click Fill Colour (down arrow for dropdown menu). Choose the colour.

3.5.4 Formatting Worksheets using Styles Toolbar
The use of styles in Excel allows to quickly format worksheet. In Excel, all styles are cell styles.
However, a defined style can be applied to an entire worksheet. Select the Styles from the Home

tab—> Styles group.

Applying a Style in an Excel Worksheet in order to apply an existing style in Excel,
follow the steps :

1 Select the cells to which a defined style is to be applied.
2 Choose Home tab—> Styles group—> Cell styles.

3 Select the name of the style to apply in the Cell styles.

4 Select OK.

Create a custom cell style

1. On the Home tab, in the Styles group, click Cell Styles.

TR

Conditional  Format Cell
Formatting = as Table = Styles =

Styles
2. Click New Cell Style.

3. In the Style name box, type an appropriate name for the new cell style.
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4. Click Format.

5. From the different tabs in the Format Cells dialog box, select the formatting and then
click OK.

6. In the Style dialog box, in the option Style Includes (By example), clear the check boxes
that is not needed in the cell style.

Create a cell style by modifying an existing cell style
1. Inthe Home tab, in the Styles group, click Cell Styles.

Conditional Format Cell
Formatting = as Table = Styles -

Styles
2. Select one of the following:
= To modify any existing cell style, right-click on cell style, and click Modify.
= To create a duplicate of an existing cell style, right-click the cell style, and click
Duplicate.
3. Inthe Style name box, type an appropriate name for the new cell style.
4. To modify the cell style, click Format.

5. From the tabs in the Format Cells dialog box, select the formatting and then click OK.

6. In the Style dialog box, in Style Includes, select or clear the check boxes that is not to be
included in the cell style.

Remove a Cell Style

1. To remove a cell style from selected cells without deleting the cell style, select the cells
that are formatted with that cell style.

2. On the Home tab, in the Styles group, click Cell Styles.

TR

Conditional  Format Cell
Formatting = as Table = Siyles =

Styles
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3. Select one of the following:
= To remove the cell style from the selected cells without deleting the cell style, in
Good, Bad, and Neutral, click Normal.

3.5.5 AutoFormat

Automatic formatting can make entering certain kinds of text faster and easier. The specific
options that are available depend on the program that you are using. To see and modify
automatic formatting options :

Select Office button—>Excel Options, Excel Options Window opens. Click the Proofing button at
left bar. In AutoCorrect Options section, click AutoCorrect Options button—->select AutoFormat
as you type option.

General ABC| -
= # Change how Word corrects and formats your text.
Display -
| Proofing AutoCorrect options
Save Change how Word corrects and formats text as you type: | AutoCorrect Options.. ]
Typograph:
TRERN When correcti -~
Language AutcCorrect / [
|¥! Ignore w
Advanced [
s 4] Ignore @ AutoFormat | Actions
I
Customize Ribbon ¥] Ignore I AutoCorrect Math AutoCorrect ] AutoFormat As You Type
[V] Fiag repi
Quick Access Toolbar E Geimal Replace as you type
o [P Enforce V| "Straight quotes” with “smart quotes” |¥] Ordinals (1st) with superscript
Add-Ins = £ e -
. [F] Suggest V| Fractions (1/2) with fraction character (v2)  [V] Hyphens () with dash (—)
Trust Center el 7] "Bold* and _italc_ with real formatting [7] Long vowel sounds with dash

AutoCorrect feature is used to correct typos and misspelled words, as well as to insert symbols
and other pieces of text.

Select Office button—> Excel Options, Excel Options Window opens.

Click the Proofing button at left bar. In AutoCorrect Options section, click AutoCorrect options
button.

Excel Options

G I ABC|
enee g; Change how Excel corrects and formats your text. [

AutoCorrect options
Change how Excel corrects and _
formats text as you type: Auto&:rrect Optl_ons‘.‘ £

When correcting spelling in Microsoft Office programs

Formulas

Proofing

Language

Advanced

Customize Ribbon
Quick Access Toolbar
Add-Ins

Trust Center

Ignore words in UPPERCASE

Ignore words that contain numbers
Ignore Internet and file addresses
Flag repeated words

|:| Enforce accented uppercase in French

|:| Suggest from main dictionary only

coce
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3.5.7 Format Painter

This tool gives the ability to make a format somewhere in the document and then apply it
somewhere else.
Format a cell using the Format Painter. Select any cell.
e On the Ribbon, select the Home tab > in the Clipboard group > click Format Painter.
e Select cell.
e The formatting of the cell has changed and the Format Painter will be inactive until it is
selected again.

o)\ HI -0 B 7|7 VEp)
i

Home Insert Page Layout References

== % cut

Ptj 53 Copy
aste - : Aa-
- # Format Painter i e [

Clipboa, (F Font

| |-2-|-1-|-§-|

Times New Roman | -

3.6 Formulas and Functions
3.6.1 Formulas

Formulas are entries containing an equation that calculates the value to be displayed. Formulas
are used in: (a) simple addition, subtraction, multiplication and division, and (b) complex
formulas involving a combination of arithmetic operators.

3.6.2 Operators
An operator is a special symbol that tells a programme what action to take on a series of
numbers. There are two kinds of operators:

(a) Mathematical operators and (b) Comparison or logical operators.

(a) Mathematical Operators: These operators are used to add, subtract, multiply, and divide
numbers. The following are the 5 mathematical operators.

Operator Explanation Example
Symbol

A Exponential =412

+ Addition =4+2

- Subtraction =4-2

* Multiplication =4*2

/ Division =4/2
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(b) Comparison Operators: These operators are used to compare one value to the other. These
operators are also called logical operators because the resulted answer in the cell is always either
True or False.The following are the comparison operators.

Operator Symbol | Explanation Example
= Equal to =C1=10
> Greater than =E5>50
>= Greater than or equal to | =D5>=20
< Less than =E1<20
<= Less than or equal to =C5<=10
<> Not equal to =F1<>10

Basic Properties of a Formula
1. A formula may consist of operators, cell references, range names, values and functions.
2. A formula always start with an equal to (=) sign.

3. When a formula is entered in the cell, and then the ENTER key is pressed, only the
calculated result is displayed in the cell and not the formula.

4. If a cell containing formula is made an active cell, though it still shows the value, but
in the formula bar, the formula is displayed.

3.6.3 Creating a Formula

Formulas are to be entered in the cell and with an equal sign “=". When the formula is typed in
the cell, it is calculated and the formula is visible in the formula bar.

3.6.4 AutoSum

It automatically adds the values.
Ex. The AutoSum function to add the contents of 5 cells.

1. Select the cell range J5:J8.

2. Select the cell that the sum will appear in that is outside the cluster of cells whose values will
be added, Cell JO.

3. Click the Formula tab—>Function Library group—> AutoSum.

4. The sum will be displayed in cell J9.
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I Delete ~
Cell poul Sort & Find &
v Styles~  (mdFormat~ | 2~ Fiiter~ Select~
Cells Editing
Sum (Alt+ =)

Display the sum of the selected
cells directly after the selected cells,

3.6.5 Relative, Absolute and Mixed Referencing

Relative Referencing: Calling cells by just their column and row labels (such as “A1”) is called
Relative Referencing. When a formula has Relative Referencing and it is copied from one cell to
another, exact copy of the formula is not created. It will change cell addresses relative to the row
and column to which they are moved to.

SUM v (3 X o S| =D2*A2
A | B —-— D | E A F
1 |Cost Unit size Size Inventory Total Cost
2 100 1Kg 2 200 =D2*A2
3 200 1Kg 5 1000
4 | 150 1Kg 1 150

Relative Reference

When the formula in F2 is copied and pasted to F3, the formula in F3 will
appear as =D3*A3 because it is a relative reference
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Absolute Referencing: To prevent the cell addresses to change, a dollar sign “$” is placed
before column and row location in the formula. The references become absolute and they will
not change when copied.

] SUM » (3 % « £ | =D2*3A%2
A B C D E F
1 Cost Unit size Size Inventory Total Cost
2 100 1Kg 2 200 =D2*SAS2
3 200 1Kg 5 1000
4 150 1Kg 1 150

Absolute Reference

The $ sign makes this an absolute reference. Now, cell A2 will
remain constant in the formula.

Mixed referencing : It is a combination of relative and absolute reference.
For example, in the formula “=(D2$+$A$2)”, the row of cell D2 is fixed and the column of cell
A2 is fixed.

3.6.6 Functions

The built-in formulas are called functions. The users have to provide the cell references or
addresses only. These are called arguments of the functions that are given between a pace of
parentheses ( ). The functions perform the operations on the given values and return the result
that is displayed in the same cell where the function was entered. They perform mathematical
operations more efficiently than formulas. For example, to add the values of cells D1 through
D10, type the formula “=D1+D2+D3 +D4+D5+D6+D7 +D8+D9+D10”. A shorter way would be
to use the SUM function and simply type “=SUM(D1:D10)”. Several other functions and
examples are given in the table below:

(@) SUM() function - Adds all the numbers in a range of cells.

The Syntax is
=SUM(number1,number2,...... )

Ex. =SUM (A1:A4) finds the sum of cells Al through A4

.~ K v | =SUM(AT:A)
A B
1 20
2 50
3 60
4 50
5 =SUM(ATA%)|
6 [SUMinumberi, [numberZ], ..} |
7
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(b) AVERAGE() function - Returns the average (arithmetic mean) of the arguments
The Syntax is

=AVERAGE(numberl,number2,...... )

Ex. =AVERAGE(A1:A10) finds the average of cells Al through A10

(c) MAX() function - Returns the largest value in a set of values.

The Syntax is

=MAX(numberl,number2,.....)

Ex. =MAX(AL:A10) returns the highest number from cells Al through A10

(d) MIN() function - Returns the smallest number in a set of values.

The Syntax is

=MIN(numberl,number2,....... )

Ex. =MIN(A1:A10) returns the lowest number from cells Al through A10

(e) COUNT() function — Returns the number of cells that contain numbers.
The Syntax is

=COUNT(valuel,value2,....... )

Ex. =COUNT(A1:A10)

_ B9 - fi | =COUNT(B1:B3)
4 A B cC D E F
1 12 150
7i 27 85
3 24 65
4 Sum 63 300
5
6 | Average 21 100
7 Min 12
& Max 27
9 Count | 3|
10 |
11

() COUNTIF() Function — It is used to count the number of cells within a range that meet the
given criteria.

The Syntax is

=COUNTIF (range, criteria)

Where range is the location of all the values from which the COUNTIF will choose and criteria
are the expressions, text, or values that define which cells will be counted.

For example, Find the number of students who have scored more than 80 with the formula:
=COUNTIF (A1:A10, “>80”) in quotes using comparison operator.

(9) SUMIF() Function — It is used to add the numbers in the range that meet the given criteria.
The Syntax is

=SUMIF(Range, Criteria)

For example, Find the total marks of students who have scored more than 80 with the formula:
=SUMIF (A1:A10, “>80")
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In this formula the range A1:A10 is the range of marks of 10 students and the criteria is specified
in quotes using comparison operator.

3.6.7 Spell Checking

Checking for possible spelling mistakes and then confirm each correction. To spell check all of
the sheets in a workbook: Select the Review tab—>Proofing group Click Spelling option.

3.7 Using Charts

Charts allows to present data entered in the worksheet in a visual format using a variety of graph
types. Before making a chart, first enter data into a worksheet.

3.7.1 Components of a Chart

Chant Title: Title and
Subtitle sultitle
Ticks 2500
B ]
Value - T Range A
Axis 9e
Title 1000 mRange B
“alug [ ) ———"""
iz 500 1
UGy T T
/ Descrip & Descrip B YDescrip © Legend
p P P
Crigin Category Axis THR

Category () Axis

There are a number of components of a chart. Some of the major components are:
Chart Title : A title given to the whole chart.

X-Axis Title : A title given to the X-axis data range.

Y-Axis Title : A title given to the Y-axis data range.

X-Axis Category : This is the category of the data which have been plotted. These are taken
from the first column or first row of your data range.

Y-Axis Value : This is the data range marked to plot the data series.
Data Labels : The values of the data series plotted.

Legends : Specifies the colour, symbol or pattern used to mark data series.
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Tick Marks : These marks are used to show the scaling of X-axis and Y-axis.
Grid Lines : Displays lines at the major intervals on the category X-axis and/or Y-axis.
3.7.2 Chart Types

Select a Chart from a set of chart types in step 1 of the Chart Wizard. Some of the chart types
are :

Column Charts : They compare distinct items. In this chart category axis is horizontal (X-axis)
and value axis is vertical (Y-axis). It is important to keep the number of series in a column chart
to a minimum. Many series cause the column to become narrow and difficult to analyze. Column
charts are used to compare the results.

Chart Title

80000

60000
2 B Maruti
= 40000 -
n B Honda

20000 - M Tata

0 - ® Hyundai
2012 2013 2014 2015
Year

Bar Charts : Compare different items or show single items at different intervals. It is similar to
column chart except that the chart value axis is horizontal (X-axis) and category axis is
vertical (Y-axis).

Chart Title

2015
= 2014 B Hyundai
(]
> 9013 ™ Tata

2012 B Honda

! ! i B Maruti
0 20000 40000 60000 80000
Sales
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Area Charts : They show the relative contributions of each value to a total over time.

80000

60000
n B Maruti
2 40000
» 0 H Honda

2000& W Tata

0 B Hyundai
2012 2013 2014 2015
Year

Line Charts : These charts are useful to compare the trends over time.

Chart Title
80000
60000 7—4_/__—é —— Maruti
< 40000 - —
& 20000 Honda
0 Tata
2012 2013 2014 2015 = Hyundai
Year

Pie Charts : The chart show the proportion of each part value to the total value in a data series.
They are used to show proportional sales figures or representation of different categories of
population like workers/non-workers, male/female, adults/children, etc.

Maruti

m 2012
m 2013
w2014
m 2015

44



3.7.3 Creating a Chart

1. To create the chart, create the worksheet.

A B C D E

1 Sales Analysis

2

2 2012 2013 2014 2015
4 | Maruti 42000 52000 61000 TE000
5 Honda 40000 43000 55000 65000
6 Tata 35000 41000 43000 55000
7 Hyundai 39000 45000 51000 BO000

2. Select the cells containing the data for creating the chart. Include the data labels. Choose the
Insert tab. Click the Column button in the Charts group. A list of column chart sub-types
appears. Click the Clustered Column chart sub-type. A Clustered Column chart is created and the
Chart Tools context tabs appear.

Chartadsy - Microsoft

Wi add-nd

—I....}_u '-_: lu?-’:":"

PeeotTabde Table Pichure Clp  Shapes Smaetirt | |[Colenn r Area  Scafter  Cther
z Adt : : z z Chats =
1 Brirationd. |L 2.0 Column =r,_ |
A3 (2 j,": Product; . d qd !
4 a i) = o idla i | | 1
1 Tﬁ"‘p’ Sales 3-0 € Clustered Column
2
3 [Froducts Ragionl Region 2 Ragion3 i bt b e
4 [Daolls 2478 2640 23BE ﬂ
5 [Trucks 201 1173 2790 | ¢ ina ':,"','ﬁ_f,,',‘ S egenss
6 |Puztles 1918 2722 2745 e cownts fuch a5 & helogr e
; 6427 7535 7973 | ' -, I'I ‘]TI T I[ '[[
9 S
11 | i [ 'I_ll ¥
iuf Jab] 48] 84|

3. Apply a Chart Layout : Click the chart. The Chart Tools become available. Choose the Design
tab. Click the Quick Layout button in the Chart Layout group. A list of chart layouts appears.
Click Layout 5. Excel applies the layout to your chart.
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Chartxisx - Microsoft Excel Chart Taols o

Farmulss Data W WView Add-ins Design Fpaul
e bt (kb d
n.c@ el Queck I I I
o Crata Layout = || —
b | e .iwfa f-u_;'_"-
H I J

=
=
1 e

dut e e @

Tl | moolks
B Trucks

4. Add Labels : When a layout is applied, it create areas where labels can be inserted. Labels are
used to give chart a title or to label axes. Enter the title, axis title.

Toy Sales
Kl
4300 |
w 2000
3 1300
i L r
S5O0
o | i .
Reginn 1 d Ragion 3
m Dadli 1478 F{- 1383
® Truchs Foily] 2173 FTGG
B Puiiies 1913 FEFE iy

5. Change the Style of a Chart : A style is a set of formatting options. Style can be used to
change the colour and format of the chart. Excel has several predefined styles. They are
numbered from left to right, starting with 1, which is located in the upper-left corner.

Click the chart. The Chart Tools become available. Choose the Design tab. Click the More

button in the Chart Styles group. The chart styles appear. Click any Style.
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T I Chartalss - Micresoft Excel P L) ey
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6. Move a Chart to a Chart Sheet - By default, when a chart is created, Excel embeds the chart in
the active worksheet. However, the chart can be moved to another worksheet or to a chart sheet.
A chart sheet is a sheet dedicated to a particular chart. By default Excel names each chart sheet
sequentially, starting with Chartl. One can change the name.

Choose where you want the chart to be placed:

@ New sheet: |Toy Sales ‘—@
Lﬂ:ug Objectin: | Sheetl EI

7. Change the Chart Type - Any change can be made to a chart that is embedded in a worksheet,
one can also make to a chart sheet. For example, Chart type can be changed from a column chart
to a bar chart.

8. Save and close the file.
Practice Questions
I. Fill in the blanks:

a) Formulas in Excel start with
b) The intersection of a row and column is called

c) An Excel workbook can have number of
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d) The function is used for calculating average.

e) A selected cell in Excel is called

f)A is a group of cells.

g) In referencing, the cell reference does not change while copying formulas.
h) A spreadsheet is also called

Il. Answer in brief:

1) What is the method of copying formula?

2) How do you add data to the chart?

3) What do you understand by AutoFormat feature?

4) What are the different types of Charts?

5) Differentiate between the SUMIF() and COUNTIF() functions.
6) What is the function of Autofill feature?

7) Differentiate between relative and absolute referencing?

8) What are the uses of operators in Excel?

I11. Reproduce the following worksheet & save it, insert a title Half Yearly Sales

A B C D E F G
Name January | February | March | April | May | June

1 Mr. Dinesh | 20000 | 10000 5000 10000 | 50000 | 70000
2 Mr. Manish | 25000 | 30000 20000 | 12000 | 40000 | 45000
3 Mr. Sahil 30000 | 18000 16000 | 28000 | 30000 | 40000
4 Mr. Mohan | 20000 | 22000 18000 | 23000 | 28000 | 30000
5 Mr. Harish | 25000 | 28000 16000 | 30000 | 34000 | 40000
6 Total

7 Average

8 Highest

9 Lowest
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Using Formulas

a) Calculate Total for each month and display them in cells B7, C7, D7, E7, F7, G7
respectively.

b) Calculate Average for each month and display them in cells B8, C8, D8, E8, F8, G8
respectively.

c¢) Calculate Highest for each month and display them in cells B9, C9, D, E9, F9, G9
respectively.

d) Calculate Lowest for each month and display them in cells B10, C10, D10, E10, F10, G10
respectively.

e) Create a column graph on a new sheet showing the heading Monthly sales for six months.
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CHAPTER 4
POWER POINT
4.1 Introduction

Microsoft PowerPoint 2007 helps to develop dynamic, easy to create, professional presentations.
It can be used to create and organize slide shows, speaker notes, handouts. It is used by teachers
and trainers to make the lecture presentations. It is used in the corporate sector to present project
plans and strategies. It improves the presentations with pictures, sound effects, tables and charts.

4.2 Objective
After going through this lesson you would be in a position to:

e Explain features of PowerPoint.

e Create Presentations.

e Generate Slides.

e Add text, pictures, shapes to slides.
e View slides using different views.
e Set up the slide show.

e Save and Print Presentations.

4.3 PowerPoint Presentation
4.3.1 Starting PowerPoint

1. Click on Start button on the Windows 7 Taskbar.
2. Highlight the All Programs item. The menu will open.
3. Select Microsoft Office from the list of programs.

4. Click on Microsoft PowerPoint 2007.
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¥ Windows Update

) Accessaries

@ Games

. Internet
Mozilla Firefox

[ E-mail @) Mozilla Firefox
@ Microsoft Office Out J@ Startup

fa Microsoft Office

5 Microsoft Office Access 2007

x Microsoft Office Excel 2007

[,_E Microsoft Office Pow| @ Internet Explorer | Microsoft Office Outlook 2007
2007 vy :
w Paint lﬂ Outlook Express Microsoft Office Publisicyeate and edit pre
¢ Remote Assistance ¥ Microsoft Office word(feh Bages by using

1l
l'__x_ -= Microsoft Office Excel &) windows Media Player

3 ‘Windows Messenger
<
m Adepe phiskostion ] @) windows Movie Maker

) _ Adobe Bridge €53
Windows Media Plays
Adobe Device Central CS3
“ MSH % Adobe ExtendScript Toolkit 2
ﬂ Adobe Photoshop €53
PURTZNTELE A | Adobe Stock Photos €53

@] Log OFF @] Turn O

4.3.2 Creating a Presentation
1. Select Office button=>New
2. New presentation dialog box opens.

3. Select Blank Presentation. Click Create.

- s Pre 1 - Mecronclt Power? -
(O \dan
Home | Insert Design Animationy Shde Show Fraew View ASSing
— : z
o -} =3z .
;;3.4 ”—]::.;Jnlu-s-sﬁ
ew =l TR
o S osnger A ACA R
| Copboars T Sades font

Click to add title

Clickto add subtitle

Click to add notes

4.3.3 Open an Existing Presentation

1. Select Office button->Open.

2. In the open dialog box, select the file name.
3. Click on open.
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4.4 Viewing Slides

PowerPoint consists of different views to help in the creation and presentation of slides. The
views are Normal View, Slide Sorter View, Notes Page and Slide show.

View tab—->Presentation View group

@ H © 0 T O \rg & My First PowerPoint Presental
FILE HOME INSERT DESIGM TRAMSITIONS ANIMATIONS SUDE SHOW REVIEW VIEW I

ENEENEE (] Ruler E Q = B Color

[ Gridlines = = Grayscale

jarmal Outline  Slide  Motes Reading ] Slide Handout Motes ] Motes  Zoom  Fitto .
View Sorter Page View | Master Master Master L] Guides Window mm Black and White
Presentation Views Master Views Show Ta Zoom Colar/Grayscale

Normal View

It is the default view where one can write and design presentation. It has four working areas:
Outline tab, Slides tab, Slide pane, Notes pane. In Outline tab it displays small images called
thumbnails. Slides tab shows all the text on the slides. Slide pane shows the currently selected
slide. Notes pane is used for entering notes about the current slide.

Slide Sorter View

It displays the thumbnails of all the slides in the presentation. It allows to sort, move, add and
delete slides easily.

7| bame | et Degn  dnieatons  Sidesnow  Reiew  Vew  Dewioper 4

o s A (B
— 43 Copy Bjpaset Jan
T° JFomatPater | ueee 3 Delete

(B7 U8 puA|[ES
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Notes Page

It displays a page layout of the notes and the slide. It allows to rearrange the notes and compare
them to the content of the slide.

Slide Show View

It displays the presentation from the beginning with animation.
4.5 Working with Slides

4.5.1 Adding a Slide

1. Select Home Tab—>Slides Group—>New Slide.
2. It adds a new slide in the default layout “Title Slide”.

(Oq) 90 F

i
il
—-“} Insert Desig

# =] Layout -
55 EReset
e gw;:taﬁ:l Deleta
Clipboard T

Changing Slide layout

1. Select Home Tab—>Slides Group—> Layout.
2. In the Office Theme box select the layout.

[—_:] un '] A=

Office Theme

Title Slide | Title and Content Section Header

Two Content Comparison Title Only

T
Elank Content with Picture with
Caption Caption
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4.5.2 Deleting a Slide

1. Select Home Tab->Slides Group—> Delete.
2. The current slide will be deleted.

4.5.3 Adding Text
In PowerPoint text is added using text box.

1. Select Home Tab—>Drawing Group-> Text box
or Insert Tab—>Text Group-> Text box.
2. Click on the text box.
3. In the slide, click and drag the mouse to draw a text box.
4. Type the text within the text box.

4.5.4 Move a Text Box

1. Select the text box.

2. Bring the cursor over the border of the text box.

3. The cursor will change to the move icon (2 crossed arrows).
4. Click and drag with the mouse to move the text box.

45,5 Format Text

1. Select the text in the text box.
2. Click Home Tab.
3. In the Font group and Paragraph group, the font, size, style, color, alignment of the text.

4.5.6 Adding WordArt

1. Select Insert tab—> Text group—>WordArt.
2. Click WordArt, select the style from the list.
3. Type the text.

Insert Design Animations Slide Show Review View

NVl I ﬂ Q2w & 9

C\p Pho t Sh p s SmartArt Chart | Hyperlink Actio mbol Object Mmtie Soun
Art  Albul

Tlustratiol Links

M\
R A R I R L FIANY

A A/

| SN . —
E
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4.5.7 Format WordArt

1. Select the WordArt.

2. The Drawing Tools tab appear at the end of the Ribbon Tabs.
3. Click on the Format Tab.

4. Format the selected WordArt in WordArt Styles Group.

4.5.8 Adding Shapes, Image and ClipArt

1. Select Insert tab-> lllustrations group-> Shapes.

2. Select the shape from the list of shapes.

3. Click on slide to insert the selected shape.
Adding an image from a file

To add an image from a file in the computer.

1. Select Insert tab-> lllustrations group—>Picture.

2. Select the picture from the Insert Picture window.

Adding an image from Clip Art

1. Select Insert tab-> lllustrations group—>Clip Art.
2. In the Clip Art task pane, in search for text box, type a word or phrase that describes

the Clip Art.
3. Click Go.
4. In the list of results, click the Clip Art to insert it.
Pld D~ v entrastsand - Wiirosoh Pawedeet =
m -.m. . r  Deign  TemsBor  Ammstiom  SheShow  Rwwew  View . B @

Click to add title

% |

@’é\ =) (mic. o @ € H'\ www.geekyshows.com

Cick b addd notes

2

55



Formatting an image and Clip Art

E"a\ = 9 - 7 introduction.ppt [Compatibility Mode] - Microsoft PowerP... || Picture Tools
L] ettty
—-j Home Insert Design Animations Slide Show Review View | Format
i Brightness = :;{ Compress Pictures — — — 4? Picture Shape - H:;_I; Bring to Front ~ |= - _:,IJ
(B Contrast - E,E Change Picture |-d‘ |d| d = L_a_’ Picture Border ~ Lﬂ:h Send to Back - m'
5i
{m Recolar = QE Reset Picture = | & Picture Effects = L_"‘]b Selection Pane Sk~ IEE
I Adjust I IF‘if:ture St}.-'lesl IF] I.ﬁ_rrange I
1. Select the Image/Clip Art.
2. The Pictures Tools tab appears.
3. Format the image using Adjust, Arrange and Picture Styles group.
Formatting Slide Design
6,3\ [H ¥ - & )5 introductionppt [Compatibility Mode] - Microsoft PowerP... | Dprawing Tools - =
33 }

—/ Home Insert Animations Slide Show Review View Format !

e i . Colors = I& Back . I
/ ground Styles
1] Lli Aa Aa - Age— Aa Al A2 Nz eons - |2
Page Slide - mm EmEEE EEEE mEE | ((mmmm== (1] — T Hide Background Graphics

Setup Orientation ~

Page Setup Background Fi

4.6 Adding Theme to Slide

1. Select Design tab—> Themes group.

2. Select the theme.

3. The theme is applied to all the slides in the presentation.

The Color, Font and Effects for the current theme can be changed using Color, Font, Effects
options from Themes group.

4.7 Changing the Background

1. Select Design tab—> Background group—> Background Styles.

2. Click on Format Background.

3. The dialog box will appear.

4. One can set the color, solid or gradient, transparency or choose picture/texture fill.

5. To apply to current slide, choose close. To apply to all slides, choose Apply to All.
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4.8 Formatting Presentation Using the Slide Master

The slide master is template for the entire presentation. Changes made in slide master will
change the formatting of all the slides in the presentation. Select View tab—>Presentation Views
group—>Slide Master. The Slide Master tab appears. Select the top Master Slide, edit the
background, background styles, slide titles, slide animation.

4.9 Objects and Animation

D_ﬁ\ H9-0 + Drawing Tools  introduction.ppt [Compatibility Mode] - Microsoft Power.. - g

9
—-j Home Insert Design Slide Show Review View Format

';é]' {24 Animate: | FlyIn . L _‘ _‘ dl, Transition Sound: | [No Sound] || Advance Slide
il J J J JJ J @ » Bl Transition Speed:  Fast = | ¥/ On Mouse Click
Preview || 2 cystom Animation = 13 Apply To Al Automatically After: 00:00
IF'revie»\I | Animations | Im‘

4.9.1 Create Custom Animation Effects for Objects
1. Select Animation tab—> Animations—>Custom Animation.
2. Custom Animation Panel appears on the right hand side of the current slide.
3. Select the object.
4. Click the Add Effect button and choose an animation style.
4.9.2 Modify Animation Effects
1. Select Animation tab—> Animations—>Custom Animation
2. Custom Animation Panel appears on the right hand side of the current slide.
3. Select Modify: Blinds
Start — how to start animation.
Direction — direction of animation.
Speed — Speed of animation.
4.9.3 Create a Slide Transition

Slide transitions are the animation effects that occur between slides. Speed of transition slide can
also be controlled and sound can also be added.
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Preview Animations

1. Select Animations tab-> Transition to this slide.

2. Select the transition from the list.

3. Click on Transition Sound button to apply sound effect.

4. Click on Transition Speed button to adjust the speed.

5. Click on Apply to All the transition to all the slides.

4.9.4 Change the Order of the Slides

1. Select View tab->Presentation Views group->Slide Sorter.
2. Click on slide, drag up and down to change the order.
4.9.5 Slide Show Options

The Slide show tab of the ribbon contains many options for the slide show. These options
include:

e Preview the slide show
-> from the beginning.
-> from current slide.

e Set up the Slide show.

) d9-v@a) s , :

o3
o =
Home Insert Design Animations Slide Show Review View Add-Ins Acrobat @
'_] 5 © :‘-\1-‘3- 3 .i]. = »5 Record Narration [@l] Resolution: Use Current Resolution ~
" —_— Sl —— o . - o — . - -
. oot - - (&7 Rehearse Timings [ Show Presentation On: Primary Monitor -
From From Custom Set Up Hide i )
Beginning Current Slide | Slide Show v || Slide Show  Slide V| Use Rehearsed Timings Use Presenter View
Start Slide Show Set Up Monitors

Set Up Slide Show

This option allows to set preferences for how the slide show will be presented. The options
include:

Whether the show will run automatically or will be presented by a speaker:
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e The looping options.
e Narration options.
e Monitor resolutions.
e Record Narration.

When a record narration for the slides is to be added:

e Click the Record Narration button.
e Click Set Microphone Level to check the levels of audio input.
e Click Ok to record the narration.

4.9.6 Rehearse Timings

Use rehearse timings to rehearse the presentation to see whether it fits within a time frame.
On Slide Show tab—>Set Up group—>Rehearse Timings.

The Rehearsal toolbar appears. The presentation timing begins.

]| | 0:00:06 4= |I:I:EII:I:1?
| |

T

|
4

e
kb.'l

To set time to the presentation:

e Select Next to move to the next slide.

e Select Pause to temporarily stop recording of the time.

e Select Pause to restart recording the time after pausing.

e Select Repeat to restart recording the time for the current slide.

When the time is set for the last slide, a message box displays the total time for the
presentation and then select either yes or no:

e To keep the recorded slide timings select Yes.
e To discard the recorded slide timings select No.

Slide Sorter view appears and displays the time of each slide in the presentation.
To Save the Presentation:

e Click Save As on Office button.
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e Choose the folder where the file is to be saved.
e Type the filename and then click Save button.

Print a Presentation

Click Office button=>Print

In the Print dialog box, click the arrow next to Print What

The options available are:

e Slides — print a slide in a page.

e Handouts — prints the number of slides specified by user in a page.
e Notes Page — prints the slides and the speaker notes.

e Qutline View — prints the outline of the presentation.

Choose the option and click Ok to print.
Practice Questions
I. Multiple choice questions

1) Which of the following should be used if all the slide in the presentation to have the same
“look™?

a) The slide layout option.

b) Add a slide option.

c) Outline view.

d) A presentation design template.

2) Special effects used to introduce slides in a presentation are called
a) Effects.

b) Custom animations.

c) Transitions.

d) Present animations.

3) How can you create a uniform appearance by adding a background image to all slides?
a) Create a template.

b) Edit the slide master.

¢) Use the autocorrect wizard.

d) All of the above.

4) Which of the following section does not exist in a slide layout?

a) Titles.

b) Lists.

¢) Charts.

d) Animations.
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5) The effect applied to display when slides changes in slide show view is
a) Slide Animation.
b) Custom Animation.
c¢) Custom Transition.
d) Slide Transition.
Il. Answer in brief :
1. What is Presentation? What are its uses?
2. What are different views options available in PowerPoint?
3. What is the difference between a presentation and a slide?
4. Write the steps to insert ClipArt in a slide.
5. Write steps to insert textbox and WordArt.

6. What is the difference between animation and transition?
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CHAPTER 5

INTERNET SEARCH
51 Introduction

The Internet consists of millions of private/public/academic/business and government networks
having local to global scope. It has billions of web pages. As compared to searching a database,
the search for a document contents is more terrifying since is not structured. We need the
services of the Search Engines for finding the documents on the Internet. When a user enters a
query into a search engine, the engine examines it as index and provides a list of best-matching
web pages according to its ranking criteria.

52  Objectives

At the end of the unit, the student should be able to understand:
e Function of search engine.

The role of search engine in browsing.

The different search engines.

Uses of search engines.

Function of E-Commerce.

5.3  Search Engine

A software application or service used to locate files on an intranet or the Web, generally
accessed with browsers. It is needed for the same reason you need a card catalogue in a library.
There is lots of great and useful information in a library, but it’s physically impossible to
examine all the books personally. There are millions of pages and billions of words on the Web
and more are being added.

A Search engine can be defined as a tool to search these disorganized sources of information
available on the Internet. Using a search engine is pretty simple. Just type in the data to be
searched, the space provided at the search engine’s current page, and click search. The result
will be displayed with information corresponding to the search in the form of a list of web-sites
that match that word or phrase. A search engine is a critical tool in finding information, products
and businesses on the web.

54  Types of Search Engine:
There are three basic categories of Search engines:

1. Primary Search Engines: Such search engines use web crawlers or spiders. Google and
AltaVista are examples of the same.

62



2. Web Directory: Web directories organize information into categories and subcategories.
Directories differ from search engines in the way they organize information. Yahoo is an

example of Web-directory.

3. Meta Search Engines: Such search engines pass your queries to many search engines
and web directories and present summarized results to the users. Some of the examples
of meta search engines are — Dogpile, Infind, Metacrawler, Metafind and Metasearch.

Some of the popular Search Engines on the Internet are:

Google
Bing
Yahoo
Baidu
AOL
Ask.com
Excite
Lycos
Indiatimes

Rediff

https://www.google.com/
https://www.bing.com/
https://search.yahoo.com/
http://www.baidu.com/
http://www.aol.com/
http://www.ask.com/
http://msxml.excite.com/
http://www.lycos.com/
http://www.indiatimes.com/

http://www.rediff.com/

5.5 Finding Information through Search Engine

1. Connect to the internet.

2. Open browser.

3. Type the address (URL) of the search engine in the browser.

4. Home page of the search engine opens.

5. Type the query in the search box, press enter.
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/= Google - Windows Internet Explorer

@1«' 28 hrtp: fpwwew. googie. com/ v 4 X
Fle Edt View Favorites Tools Hep
Norm ~A hing otectio < \mueﬂmysele- @85 Log-ins
W S 2P cooge 2 - B - dw v -rPage v & Tooks -
Web Images Maps News Shopping Gmail more v iGoogle | Sign in
| Agvacced Sesccn
e
[__Google Search ][ I'm Feeling Lucky | Leoovage Yook
chedising Programs - Busi 0 - About Google
Make Google my homepage
2009 - Puiveok
Done |  @mwemet | ®i00% -

The Search requested travels to the Search Engine’s WebSite. There, the query terms are
matched against the index terms in the site’s database. The matching references are returned to
the computer as result and displayed on the screen. Each result shows the title of the document.
By clicking the title, link to the document can be made. Under the title is a brief description
consisting of few lines of text in the document. Under the brief explanation, is the URL or web
address of the document.

|/ G delhi-Google Search X

€ - C | @ https://www.google.co.in/search?q=delhi&oq=delhi&ags=chrome..69i57j69i5913j69i60j69i61.1777j0j8&sourceid=chrome&ie=UTF-8

i Apps €% Settings [[] Cheap Air Tickets, Fli

GOGALE e A | Tl s |
Al Maps  News Images  Videos  Morev  Searchtools ol
About 41,90,00,000 results (0.45 seconds)
Delhi Govt Portal: Home Rohtak Sonipat Meerute
www.delhi.gov.in/ v )
Portal of Delhi Govemment is a single window access to information and services being provided by 34
the various department of Govt. NCT of Delhi Ghaziabad

3348 New Delhi®_ Noida

Delhi - Wikipedia, the free encyclopedia Gur‘gavo -
https://en.wikipedia.org/wiki/Delhi v H

Delhi officially the National Capital Territory of Delhi, is a city and the capital territory of the Republic of
India. It is bordered by Haryana on three sides and by
New Delhi - History of Delhi - Delhi Metro - Chief Minister of Delhi

:: Welcome to Delhi Tourism :: Official Tourism Website for Government ...
www.delhitourism.gov.in/ v

Official website of Delhi Tourism, Govemnment of NCT of Delhi. Website provides information about
Travel places, Accommodation, Culture, and Heritage,

In the news
= " Google says you cannot die from Chikungunya: Delhi
health minister Satyendra Jain
Times of India - 6 hours ago
Resolute on his stand, Delhi’s Health Minister, Satyendra Jain, has reiterated
that

You Can't Die Of Chikungunya, Google Says So: Delhi Health Minister Satyender Jain

o
Faridabad

Delhi

Indian union territory

Delhi, India’s capital territory, is a massive metropolitan area in the
country's north. In Old Delhi, a neighborhood dating to the 1600s, stands
the imposing Mughal-era Red Fort, a symbol of India. and the sprawling
Jama Masjid mosque, whose courtyard accommodates 25,000 people.
Nearby is Chandni Chowk., a vibrant bazaar filled with food carts, sweets
shops and spice stalls

Area: 1484 km?

Population: $.879 million (2001) Undata

1SO 3166 code: ISO 3166-2:IN

Official animal: Nilgai

Colleges and Universities: University of Delhi, more

IIEI =

6:32 PM

- 5 [ .l
il g s 06

During the web search there are some simple rules to keep in mind. Generally the more
keywords are used in search the more specific and accurate will be the results. For example, a
search for the “Sania Mirza”, will produce better results if the search is with the keywords "Sania
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Mirza" and if the search keyword is just "Sania™ which might bring up links to websites
containing references to another person named Sania.

Operators are the rules or specific instructions used for making a query in a keyword search. A
well defined query improves the chances of finding the information being searched for. Each
search engine has its own operators; some operators are used in common by a number of search
engines.

Most search engines support Boolean Search, such as AND (+), OR (either or two) and NOT (-),
> (used for exact phrase). () Parentheses are used to group parts of the search phrase, * Asterisk
is used to search for various forms of word.

Boolean Operator

Boolean Operators AND, OR and NOT are used to connect words and terms in the query

AND Operator

AND is the default operator in search engines. So whenever more than one keyword is typed, the
search engine will automatically connect them with the AND operator. This search will retrieve

records with BOTH search terms present. It is used to narrow the search.
Example: Wind AND Fire

/& wind and ire - Google s- x \ [SI=lE e
€ > C @ https//www.google.co.in/#q=wind+and+fire 7 =

i Apps £ Settings [[] Cheap Air Tickets, Fi
GOQLLE  wind and fire s ﬂ £ m

All mages /ideos News Shopping  Morev  Search tools o]

About 29,10.00,000 results (0.38 seconds)

Wind and Fire Eco-Sustainable Jewelry

www.windandfirejewelry.com/ v See results about
Made m' ‘tlte USA from rec»,‘n\red brass. our jewelry FO‘[GE(IOV\S are finished with antique gold or antique Earth, Wind & Fire (Band) BT
silver. We place meaningful, distinctive and beautifully Songs: September. Boogie Wonderland, Let's Groove 7
Expandable Bangles Store Locator Members: Maurice White, Philip Bailey, Verdine White,
Charms for Charity \ Expandable Find Wind and Fire Jewelry at a store
Bangles. Wind & Fire takes a near you. Use our handy

More results from windandfirejewelry.com »

Earth, Wind & Fire - September - YouTube
itube.com/watch?v=Gs069dndiYk v
- Uploaded by E dandFireVEV
w @ Do you remember the 21st night of September? __. Music video by Earth, Wind &
ISR Fire performing September

Earth, Wind & Fire - Boogie Wonderland - YouTube
APVBI0 v

rth, Wind & Fire performing
Mix

Earth, Wind & Fire - Wikipedia, the free encyclopedia
https://en.wikipedia.org/wiki/Earth,_Wind_%26_Fire v

Ttk MR- 0 P ITUIPLi oo A--osio- bo-dsngt has spanned the musical genres of R&B, soul
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OR Operator

By using OR operator search results will contain either one or several or all of the search terms.
It is best used when one want to pull together results on similar topics. OR operator is used to
EXPAND the search.

Example: Wind OR Fire
NOT Operator

It is used to exclude keywords from search. It is best used when the search is ambiguous. Instead
of NOT — (dash) can also be used. NOT operator is used to narrow the search by eliminating
term.

Example: Wind NOT Fire or Wind -Fire
Phrases

Search syntax involves using quotation marks (") around a specific phrase. Phrases are very
useful at narrowing down search results to pages that contain the exact, specific string of
characters written as a phrase.

Example: If "Padma Shri Award Winners 2014" is searched for, the search results now will only
bring back pages that have all these words in the exact order that is typed them in.

5.6  Different Search Engines
In brief, here is a quick run-down of some well-known general topic search engines:

Google: The full form of Google is “Global Organization of Oriented Group Language of
Earth”. It is a powerful tool. It would be practically impossible to find out the information
without Google. It was launched in January 1996 and it is based on Logical ‘AND’ with 3-D
Keyword search operation.

Yahoo!: The word "Yahoo" is an acronym for "Yet Another Hierarchically Organized Oracle".
It is a web search engine owned by Yahoo. As of February 2015, it is the third largest search
engine in the US. Yahoo was launched in January 1996. It is actually a directory — a subject
index. It searches on a subject or topic and is based on Logical ‘And’ and wildcard after each
search word. It is a filtered search site. A search agent, category based approach and recently
switched to 3-D search Google technology.

Rediff: Rediff search engine is one of the leading internet portals in India. Its headquarters are in
Mumbai, New Delhi and New York. It was founded in the year 1996. It maintains a directory
categorically and uses Inktomi search technology. It is the only websites that appears in the first
100 websites. It is one of the best search tools in the world. It has been designed to meet the
needs of Indians worldwide. Yet it is balanced in such a way that it does not compromise on
accuracy for non-Indian topics.
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Lycos: It is the oldest search engine. It is big, thorough and comprehensive. It was originally
developed in July 1994. It is gradually becoming more like yahoo, acting as a Web Directory as
well as a search engine. It used logical operation “OR” and customized search.

Indiatimes: It is called an Indian Search Engine. It is powered by Google. It has divided search
into “The Web”, “News”, “Indian directory” and “Indiatimes Channels” It does not supports
“OR” operators and wildcard entries but supports Logical “AND” based 3-D keyword search
plus smart search by Autonomy (A Software). Web directories that are India-specific are also
included.

5.7 E-Commerce

As the Internet makes way for new business transactions via its complex telecommunications
network, it is difficult to provide a single all encompassing definition of e-commerce. It means
different to different people. A broad definition of e-commerce is: “The marketing, promoting,
buying & selling of goods electronically, particularly via the Internet”. A narrower definition is
“the trading of goods and services in which the final order is placed over the Internet”. In
fact E-Commerce is the subset of E-Business.

5.7.1 Types of E-Commerce

It is necessary to consider the various forms that Internet Commerce embodies in order to
understand the implications for taxation. E-commerce can be categorized in four ways:

Business to business (B2B); www.vendome.niit.com
Business to consumer (B2C); www.indiatimes.com
Consumer to business (C2B); www.makemytrip.com
Consumer to consumer (C2C); www.ebay.in

5.8 E-Business

E-business refers to all aspects of a business where technology is important. This may include
knowledge management, design, and manufacturing, R&D, procurement, finance, project
planning, human resource planning and the related activities. E-commerce is that part of e-
business that relates directly to sales & marketing. That is, e-commerce is part of the all-
encompassing world of e-business.

E-business is a wider concept that embraces all aspects of the use of information technology in
business. It includes not only buying & selling but also servicing customers and collaborating
with Dbusiness partners and often involves integration across business processes &
communication within the organization.
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http://www.indiatimes.com/
http://www.ebay.in/

Practice Questions

1. What is Search Engine? Give three examples.

2. Why Search Engine is needed?

3. Name three Boolean operators used with keywords while using Search Engines.
4. What is E-Commerce?

5. Name the different types of E-Commerce.

6. What is the use of Phrase search?

Fill in the Blanks

1.When a request is sent from the browser, it is that retrieves the information and
provides it back to the browser.

2. A network of networks is called

3. B2B is called
4. There are type of search engines.
5. is the subset of E-Business.
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6.1

CHAPTER 6
EMAIL

Introduction

E-mail (Electronic mail) is an electronic exchange of messages. E-mail does not require physical
components like pen, paper for compiling information or man power for movement of message
from the source to the intended end-user. It is a quick and inexpensive way to stay in touch with
the near and dear ones almost anywhere. An email recipient doesn’t even have to be available
when email is sent to her. It is stored in the mail server and the recipient can log in and download
it at a convenient time.

6.2

Objectives

At the end of the Unit, the student should be able to understand:

6.3

Creating email account.

Reading email.

Sending and Receiving email with/without attachment.
Adding signature to email.

Forwarding an email.

Importance of Email

Email is the new age tool used for individual as well as mass communication. There are many
advantages of using E-mail as a prime mode of communication, as summed up below:

Email is Fast: Email provides the fastest mode of messaging when compared to other
modes like post, telegram etc. Just type the message, specify the recipient and click
“SEND”. Within seconds, the message will reach the end-user.

Mass Mailing: You can target multiple audiences in one go using Emailing by selecting
multiple recipients. Email is used as a marketing tool to attract the customers with latest
offers and products on the go.

Email for record keeping: Use Email as a record keeper for all your
conversations/discussions. Email can be used as a proof of dialogue between two parties
for future reference.

Growth of Organization: Maintaining and growing your e-mail database will allow you
to fully utilize the services, including free broadcast e-mails and an upgraded version of
HTML e-mails (fee applies) in order to reach more participants.
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6.4 Email Services

Last two decades have brought an exponential boom to the count of email service providers. The
service providers are putting a lot of efforts in increasing the services provided via email,
increasing the span to not just mailing but also sharing multimedia and data storage. Some of the
leading internet service providers are as follows:

Gmail (A Google product)

e 15 GB online free storage for the end-user.

e Information transmission using the HTTPS protocol to provide protection from
phishing and malware.

e The user can send attachments up to 25 MB with the mail.

e Money transfer option also available in some countries.

e Gmail Apps (in Android and iOS) provide portability to the end user.

e Mostly used for personal mail.

e Gmail connects the user with other services like YouTube, Google Play and
Google Drive.

Outook.com (A Microsoft product)

= Integration of Microsoft Office package within the Email.

= Practically unlimited storage via application OneDrive inbuilt in the mail.
= Skype messenger/ Video chat integrated within the Email.

= Use of DMARD for better security.

= Mostly preferred on an organizational level.

Yahoo Mail (A Yahoo Product)

1TB (1000 GB) of free email service.

Yahoo Messenger integrated within Yahoo mail.
Best in class Anti-spam features.

Both POP and IMAP supported by this mail service.

o O O O

Other popular emailing services are AOL mail, Hotmail, Zoho Mail, Mail.com, Yandex Mail,
Inbox.com, iCloud Mail.

The following sections provide an overview of below topics:

Opening an e-mail account.
Composing a message.

Sending a mail with attachment.
Formatting text in a message.
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e Email Actions:
o Reading a mail.
o Replying a mail.
o Printing a mail.
o Deleting a mail.
o Forwarding a mail.
e Add a signature.
e Creating folders/labels for archiving mails.

This Unit will be using Gmail to provide an overview of the above actions.

6.5  Opening an Email Account (Using Gmail)
= To sign up for Gmail, create a Google Account.
= Visit the Google Account creation page (https://accounts.google.com/signup). The
following form will appear on the screen.

Name

Choose your usemane

| prefer to use my current email address

Create a password

‘(Confirm your password

Birthday

Mamin

Gender

am

Mobile phone

=l

Your current email address

Prove you're not a robot
Skip this verification {phane werification may be

Type the text:

Location

ndia (HTET)

= Once you have filled all the personal information, click on the button “Next Step” in the
bottom right corner (highlighted in red).

= The next screen will ask you to verify the account as shown in the figure below. Press
“Continue” button at the bottom of the screen.
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https://accounts.google.com/signup

Verify your account
“You're almest done! W just nesd to verify your account before you can start wsing it.
Phone number = 01 1345 E7E2

wim  [FEETES 43210 »  (Eooghs willl only wse B pemier Sor &CCounk Sty
- «  Bsandam tedt messaging rbes may apoly

How should we send you codes?
® Text message (SMS)

“oioe Call

T | ¢

Important Google will never share your mumbser with other companies or use it for markefing purposes.

= Next screen will ask you to enter the verification code received on your mobile as shown
in the figure below. Enter the verification code and press “Continue”.

Verfy your account

Enter verification code

E453T2 -

Diidin"t gt your code? Sometimes it can take up fo 15 minuies. Fifs been longer than that, try again.

= The following screen will appear once you have created your Gmail account. Click on the
below icon to access all the applications/services available to you.

— 3

My Account  Search Maps
~

Welcome, ABC XYZ

X:0 @
PP :ViQ@
E:|

<
g
&

Control, protect, and secure your account, all in ol

My Account gives you quick access to settings and tools that let you safequard your data, protect your privacy, and decide how your
work better for you

Gmail Calendar

Y

B Sign-in & security > & Personalinfo & privacy > Lo Acc( v e roe

e

More:

Contral vaur nassword and account-acce: Ianace vour visihility settinas and the data we et lanauane ilitv and other settinas that

6.6  Composing an Email

= Click the Compose button on the left side of your Gmail page.
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= =]

Inbox
Starred
Sent Mail
Drafts (1)

More »

= The screen given below will appear on the mailbox. The arrows highlight the purpose of
various buttons and text boxes in the Compose Mail Window.

el UL UL TS T T UUL I, TISTS Jie J TEW TS TU e oUW U Jari T T T
J J s

To abci23@gmailcom » | <@mmmm  Enter Email Address Here C€ Bcc
Leave Application h Enter Subject Here
Hi Sir,

“*Your text here™™*  <mmmm  Type your mail here

Regards,
ABC XYZ

Click the
llsendll

butn
El: @0 i

= Fill in the intended username in the “To” text box. “Cc” button allows you to add users

whose responses are welcomed but not required. “Bcc” Option allows you to hide
recipient addresses from one another.
»  Summarize the purpose of mail in the “Subject” text box.
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= Enter the content of the mail in the large field below the subject line text box.
= Use “Send” button at the bottom left of the Compose Mail Screen to send the mail to the
recipient.

6.7  Sending an Email with Attachment

= Gmail provides the feature to add attachments like documents, multimedia files with the
mail.

= |n Gmail, click the Compose button.

= Click the paperclip icon at the bottom of the compose window.

ER:[enw«=o0

= Browse through your files and click the name of the file you'd like to attach.

= Click Open.

= Toremove a file attached to a message, click the x to the right of the file name at the
bottom of the message.

Gmail.png [17TK) x

6.8  Formatting Text

We can use various inbuilt text formatting options to modify the appearance of the mail. Gmail
provides the following options to modify the message text (highlighted in red in the below
screenshot).

= Bold
= |talics
= Underline

= Change Font Type/Size/Colour/Background
= Indent the message text
= Use “Bullets and Numbers” to highlight the information.
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Fomatting the mail

Hi Al

abc123@gmail_com

Formatting the mail

Increase font sfize

1. Bold your text
2. ltalic your ftext
3. Underine vour text
4.
5. Change the font colour
5. Change the font background
7. Change Font type
Regards,
ABC XYZ
Sans Serif -~ -1 - B

The purpose of this mail is to use the formatting options to beautify the appearamnce
of the mail.

I
i
[ |
' |
N

6.9 Email Actions

Email uses basic terms like Inbox, Outbox, and Sent Items etc

Gmail -

Inbox
Starred
Sent Mail
Drafts (2)

Less e

Important
Chats

All Mail
Spam
Trash

- Categories
& Social
¥ Promotions

O Updates

M Forums

COMPOSE

. which are summarized below:

“Promotion”.

Four basic categories of folders are:

1. Inbox: An inbox is the main folder where your
incoming mail gets stored in. Mails in the inbox are
automatically categorised into “Primary”, “Social” and

2. Starred (* ): Stars appear to the left of the sender’s
name in the inbox and can be marked for later use.

3. Sent Mails: Sent Mails has all the mails sent by the
user.

4. Drafts: All saved messages are available in the Drafts
folder.

Other sub folders available are as follows:

1. Important (*): Mark a message important by clicking
on the icon on the left of the mail.

2. Chats: All the chats are saved in the chats folder.

3. All Mails: This folder has mails consolidated from all

the folders(Inbox, Sent Items, Starred and Drafts).

Spam: All unwanted mails are automatically transferred.




A user can perform basic actions using the email services like:

©c 0O O O O

6.9.1 Reading an email

Reading an email
Replying an email
Forwarding an email
Printing an email
Deleting an email

* The new mails are marked bold in the inbox.
= Place the mouse pointer on the mail you want to open and click on the left mouse button

to open the mail.

= Use the backward arrow ( ) to return to the Inbox.

6.9.2 Replying an email

12:07 PM (6 hours ago) “« E|

+ Reply
ormar

Filter messages like this

Print

Add Andy from Google to Contacts list
Delete this message

Block "Andy from Google”

e Report spam

= Report phishing

Show eriginal
Message text garbled?
Translate message

Mark as unread

6.9.3 Forwarding an email

12:07 PM (6 hours ago) - E|

= Forward

Filter messages like this
Print

Add Andy from Google to Contacts list
Delete this message
Block "Andy from Google”

e Report spam

= Report phishing

Show criginal

Message text garbled?
Translate message

Mark as unread

Replying lets you send a response to a
mail in your inbox.

To reply to a message, just click in the box
below the message and type away!

Click the arrow icon in the top right corner
of the message you received.

Select the “Reply” option to open the
reply dialogue box.

When you reply, the previous text from
the rest of the conversation can be seen.
by clicking the Show trimmed content
icon.

= Forwarding lets you resend a message
in your inbox.

= Open the message you want to
forward.

= Click the arrow icon in the top right
corner of the message you received.

= Select the “Forward” option to open
the Forward dialogue box.

= Add the recipients in the “To” Text
box and send the mail.
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6.9.4 Printing an email

4 Reply

= Forward
Filter messages like this
Add Andy from Google to Contacts list
Delete this message

Block "Andy from Google”
e

Aas

Report spam

Report phishing

Show original

Message text garbled?
Translate message

Mark as unread

12:07 PM (6 hours ago) - E‘

6.9.5 Deleting an email

= Reply

= Forward
Filter messages like this
Print

Add Andy from Google to Contacts list

| Delete this message |

Block "Andy from Google”
e

as

Report spam

Report phishing

Show original
Message text garbled?
Translate message

Mark as unread

12:07 PM (5 hours ago) - E|

6.9.6 Adding a Signature

User might find it handy to print a movie
or concert ticket using a “Print” option.
Open the message you want to print.
Click the down arrow next to the reply
button, at the top-right of the message.
Connect to the printer and select Print.
To print an entire conversation, open the
conversation you want to print.

Click the "Print all" button, located above
your message panel.

User can delete unwanted/old
mails/conversations using the “Delete”
option.

Open the message you want to print.
Click the down arrow next to the reply
button, at the top-right of the message.
Click the "Delete" button to delete the
message.

User can also use Trash button (¥ )
to delete a mail.

An e-mail signature is a block of text that is appended to the end of an e-mail message that is
sent.

= Onacomputer, open Gmail.

= At the top right, click the settings icon (ﬂ).
= Select Settings.

= At the top right, click the settings icon (3).
= Select Settings.
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https://mail.google.com/

Display density:
v+ Comfortable
Cozy

tir Compact
Configure inbox

Settings

Themes

Send feedback

Help

Gmail Setup (10%)

Scroll down to the "Signature™ section and enter your new signature text in the box.

Signature: No signature

{appended atthe end of all cutgoing messages) .

Leam more _ o
SansSerif - T- B 7 U A-|ca E-EEEEWN L
Regards,
ABC X¥YZ

Organisation Name
Mobile: 9876543210

Insert this signature before quoted text in replies and remove the "-" line that precedes it

= At the bottom of the page, click Save Changes.

6.10 Creating Folders/Labels for Archiving Mails

Gmail provides labels for organizing your email messages into categories, like work, family, to-
do, read later or any other category. Labels are customizable and private to every user. They

work like folders, but one can add more than one to a message or delete labels as per the need.
Use the steps given below to create a label:

On the left, below your labels list, click More. If you don't see More, drag the gray
dividing line down to show more labels.
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- Categories
& Social
® Promotions
© Updates

M Forums
Manage labels

Create new label

= Click Create new label.
= Type the name of your new label.
= Click Create.

Email is a fast and reliable means of communication that is free and easily accessible. Email
allows people to foster long-lasting, long-distance communication. They are delivered instantly.

Practice Questions

1. What is an E-mail?

2. How can an email text be formatted?

3. How can a file be sent with an email message?

4. What is the difference between replying to a message and forwarding it?
5. Write the steps to clean the inbox of unwanted email messages.

6. How do you add a signature to email?
Fill in the blanks

1. Email stands for

2. Websites offering free email services are : ,and

3. An is the main folder where your incoming mail gets stored in.
4. All deleted mails are placed in the folder.

5. CCisusedtosenda of message to a person.
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CHAPTER 7
COMPUTER VIRUS
7.1 Introduction

A computer virus is a software program attached to a legitimate program that is destructive in
nature and infects other programs in the system by replicating and attaching itself to other
healthy programs. These harm the computer in many ways such as:

e Corrupt and delete the data or files.

e Effect the functionality of software applications.

Effect the Hard Disk by erasing everything.

Use e-mail to infect the other computers.

The processing of the computer is also affected.

The virus also spread through the files downloaded on Internet.

The virus cannot infect write protected disks or written documents, already
compressed file and computer hardware, it only infects software.

7.2  Objectives
At the end of the Unit, the student should be able to understand:

To define computer virus and its evolution

To differentiate between the Computer Virus and Biological Virus

To identify the different types of virus with their names and area of infection
To explain the damage done by the virus to computer

The process of virus infection

The effects of virus on the Operating System

To apply virus preventive measures

7.3  Computer Virus

A Computer virus is a small program that which can attach it or infect the other programs as well
as replicate itself without the knowledge of the user, like its biological counterpart, and runs
against user’s wishes. All Computer Virus are manmade. Most widespread virus infections
spread through email message attachments that activate when opened. Internet is the main reason
of Virus Infection in Computers.

Virus stands as an acronym for “Vital Information Resources Under Seige” and this concept is
not new but dates back to 1949 when John Von Neumann introduced the concept of Self
Replicating Program.

The first commercial application of viruses appeared in 1985, when two Pakistani brothers, in
order to keep track of software piracy, used Brain Virus (also known as Pakistani virus) on their
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low cost software. It was an extra program not supplied by the original manufacturer. These
types of self-replicating programs multiplied so fast and they are a threat to the smooth operation
of a computer.

7.4  Computer Virus versus Biological Virus

Computer virus is an electronic virus and Biological Viruses (Human Virus) are tiny genetic
codes DNA or RNA that take over the machinery of a living cell and are capable of making
thousands of replicas of the original virus. Like biological virus, the computer virus carries in it
an instructional code that makes copies of itself. In computer, the virus takes temporary control
of the disk operating system and when it comes in contact with an uninfected computer, the virus
passes onto the uninfected computer also.

It is assumed that Biological viruses and Computer viruses are the same entity, because both
cause infection and damage to their host/target. Although some of their features & characteristics
are same but they are quite different from each other.

7.5  Computer Virus Classification

Viruses are classified on the basis of their nature of infection and behavior. Different types
of computer virus classification are given below:

7.5.1. Boot Sector Virus

It is a type of virus which infects master boot record or hard disks. The infected code runs when
the system is booted from an infected disk. They infect at a BIOS level, they use DOS
commands to spread to other floppy disks. Since the floppy disks are not used, the propagation of
boot sector viruses has got almost over. After the introduction of boot-sector safeguards with the
Operating Systems, it is not possible for boot-sector viruses to infect the Computer.

The computer is infected by this virus only if the virus is used to boot up the system. After
completing the booting of the system and running the OS, the virus cannot infect the system.

Examples of boot viruses include: Polyboot.B, Joshi, Gravity, AntiEXE and Cbrain virus.

7.5.2. Companion Virus

Unlike traditional viruses, a companion virus is computer virus which does not modify any files.
Instead, it creates a copy of the file and places a different extension on it, usually .com. This
makes a companion virus difficult to detect, as anti-virus software tends to use changes in files as
clue.

The companion virus is an older version of virus that was more prominent during the MS-DOS.

It needs human intervention to further infect a computer but after the advent of Windows XP, as
there is no use of the MS-DOS, there are fewer ways for this type of virus to propagate itself.

81


http://www.omnisecu.com/security/types-of-computer-viruses.php

Some examples include: Stator, Asimov.1539, Stator and Terrax.1069
7.5.3. Email Virus

An email virus is a virus which is attached to email communications or sent with it. Many
different types of email viruses work in different ways, there are also a variety of methods used
to counteract such challenging cyber attacks.

Email viruses also vary in many ways. In some cases the sender of an email virus may be
unknown to a user, or a subject line may be filled with silly text. In some other cases, a hacker
may cleverly disguise the email as being from a known and trusted sender.

7.5.4. Logic Bomb

Logic bombs and time bombs are small malicious programs to cause harm at a certain point of
time but they do not replicate. They are not even programs in their own right but rather
camouflaged segments of other programs. A logic bomb may be implemented by someone trying
to sabotage a database when they are fairly certain they won’t be present to experience the
effects, such as full database deletion. In these instances, logic bombs are programmed to exact
revenge or sabotage work.

For example, a programmer could delete the critical sections of code by establishing a logic
bomb if he/she is terminated from the company. Logic bombs are most commonly installed by
the insiders who have the access to the system.

7.5.5. Macro Virus

A MAC or Macro Virus is a virus which spreads to other computers through software programs
that utilize macros. These viruses infect the files created using some applications or programs
that contain macros such as doc, pps, xlIs and mdb.

For example, Microsoft Word and Microsoft Excel are two popular and widely used programs
which have the capability of executing macros. The macro virus is initially embedded in one
document or a few documents, but it can spread to other documents within the same computer, as
well reaching out to other computers through shared documents and infect the other files,
templates and documents also. They automatically infect the files, templates and documents with
macros that are contained in the file. They hide in documents shared through e-mail and
networks.

Examples of macro viruses: Relax, Melissa.A, Bablas, O97M/Y2K.

They usually fix themselves inside the computer memory and get activated during the start of OS
and end up infecting other opened files. They are hidden in RAM.
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7.5.6. Cross-Site Scripting Virus

It is called Cross-site scripting (XSS). It is an injection attack which is carried out on Web
applications that accept input, but do not properly separate data and executable code before the
input is delivered back to a user’s browser. It mostly uses the vulnerable website as a vehicle to
deliver a malicious script to the victim’s browser. During the page loading, the malicious script
execute making the user unable to avoid the attack. The best example of XSS is Java-Script.

7.5.7. Worm

The Worm is very similar to a virus and has the ability to self-replicate itself and infect the
computer also. They travel longer distances by storing themselves in critical areas of the disk
from where they get loaded and have with them sufficient code to transfer themselves outward
from the infected system. Worms have been known to damage and infect the entire LANS.

It does not modify a program like a virus; however, it replicates so much that it consumes the
resources of the computer and makes it slow. Worms are independent programs while viruses
attach themselves to another program.

Examples of Worm: Lovgate.F, Sobig.D, Trile.C, PSWBugbear.B, Mapson, Code Red, Nimda.
7.5.8. Trojan Horse

It is similar to virus. Trojan horse is a hidden malicious code that could alter or delete the
information of client computer or perform any other unauthorized function. Trojan horses
contain programs that corrupt the data or damage the files. It can also corrupt the software
applications. Trojans can illegally trace important login details of users online — for example E-
Banking.

The activities of Trojans are:

Deleting data

Blocking data

Modifying data

Copying data

Disrupting the performance of computers or computer networks

Trojan horse does not replicate themselves like viruses and do not infect other software. The
difference between bombs and Trojans is that, the bombs are insider jobs, Trojans are brought in
from outside by unsuspecting users through other programs.

7.6  The Effects of Computer Virus
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The following may be the probable effects of Computer Virus after a virus attack:

e Computer Virus can slow down your computer performance and become inefficient or
run slowly.

e |t tends to fill up the computer with useless data.

e Virus can corrupt the system files.

e Viruses can also wipe out the Boot Sector creating problems when you boot into the
windows, which contain system information.

e |t can make the changes in the data of the programs or files and cause erratic results.

e It might steal important information from your computer and send the same to some other
person.

e It might reset or reboot a computer by sending the required codes.

e |t might format a disk by sending the formatting command to the system thereby causing
to lose everything on the disk.

e The computer gets restarted frequently by itself.

e If the virus deletes the entire keyboard definition; the computer would not be able to
respond to any keyboard inputs.

e The virus might scramble the File Allocation Table (FAT) which contains the
information for the operating system. Any mishappening to the FAT will cause data to
be irrecoverably lost.

7.7  The Vulnerability of Operating Systems to Virus

There are many Operating systems in the market such as Mac, Windows, Linux, UNIX, DOS
etc. which are being used by billions of professional and personal users. Before selecting any
operating system, there is always a question: “Which Operating System is efficient enough to
prevent virus”? Viruses are not restricted to DOS or Windows. A virus has the capability of
infecting any type of computer, irrespective of the Operating System it runs.Virus writers are like
other software developers in their desire to develop for the biggest market. It depends on the
users how long he or she can keep it off of viruses.

DOS vs. Linux
As an operating system, Linux works much better than DOS. In terms of performance Linux is

more reliable than any other operating system, even windows. It easily lowers the number of
viruses.

Windows vs. UNIX
A common belief is that UNIX as an operating is a safer option than using Windows. However,
it is true that UNIX has something different to offer to its users and many of Windows users have

experienced this while operating Windows, but after the recent innovations they may change
their opinions.
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Linux and Mac

Linux and Mac operating systems are less vulnerable to virus attack as these two systems need
advantaged access to install and run any kind of viruses. LINUX can be installed in Super
computers to embedded processors and the Windows is the most recommended OS for desktop.
People across the world are being able to use it without any major support to minimize the attack
of any Malware, especially when it is compared with windows.

7.8 Protection from Virus

We all are interested in securing our belongings such as Office, home, locality and even country
also. So we use different mechanisms to ensure the security- such as we keep our valuables
safely locked in a cupboard, we keep the doors of our houses even locked; we keep the guards to
keep secure the localities and police security within the city and armed forces for the country
also. It is always advisable to the follow the dictum “Prevention is better than cure”.
Moreover, since the viruses are made faster than the vaccines, it is a good practice to follow
some simple precautionary measures, which can reduce the possibility of virus attack. These are
as under:

= Use updated anti-virus program.

= Do not copy pirated software on your computer.

= Use the legal software from the reliable sources only.

= Do not download suspicious shareware programs.

= Use a secure operating system.

= Avoid letting the system to be used by unauthorized users.

= Allow you to schedule scans to automatically run for you.

= Scan the computer using Virus Scanner while booting up the system.

= Avoid loading of games that are passed as freeware.

= Proper backup of all data and program files should be kept.

= Remove suspicious and unnecessary files.

= Make system files “Read only”.

= Use vaccines and immunization programs to immunize computer against virus

infection.

= Always protect your password.

= Keep windows updated.

= Use the scanned USB drives.

7.9  Use of Popular Antivirus Software
Anti-virus software is a program which is designed to search, detect, prevent and remove
software viruses, and other malicious software like Trojans, worms etc.

If the computer system gets infected, despite all possible efforts, then in such cases the virus
vaccines assist you to come out of such difficulties.

The viruses are not omnipotent. Anti-virus programs help to cure the viruses. They perform one
or more the following functions:
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Prevention
Detection
Vaccination
Inoculation
Damage control

YVYVYYVYYVY

There are so many anti-viruses available in the market. One can choose any one of them on the

basis of their characteristics:

Norton Anti-Virus

McAfee

Kaspersky

Webroot

Symantec (Norton)

AVG

Microsoft Security Essentials
Quick Heal

EScan

AN N N N N NN

Practice Questions

1. Define Computer Virus.

2. What is a virus? How does it differ from an ordinary program?

3. How can you protect your computer from viruses?

4. What is the difference between the computer virus and biological virus?

5. What are the various types of viruses? Outline the net effect of each.

6. What precautionary measures should be taken in order to keep your computer safe from

the virus?
7. What is the difference between Trojan Horses and Virus?
8. What is the difference between Trojan Horses and Bombs?
9. Differentiate between Computer Virus and Computer Worm.
10. What are the effects of a virus on the computer?

11. What is meant by Anti-Virus software? Name few popular anti-virus software.
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Fill in the Blanks

1.

2.

9.

10.

11.

12.

13.

A is inactive until you execute an infected program or application.
The virus was first found in

The biological virus contains the genetic material in the form of

The full form of Virus is

Viruses do not infect files unless the file was infected prior to the
compression.

Virus can infect only computer
Boot-sector virus usually exists on
The logic bombs are used to sabotage
The worm mostly attacks the
does not replicate themselves like viruses and do not infect other software.
Which operating system is less affected by the virus
The virus is also attached with

Once installed, a program can be set to work in the background.
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LIST OF STANDARD ABBREVIATIONS
(Terms used in Office)

A

Ad. Val : Ad.Valorem

ASAP : As soon as Possible

ATM : Automated Teller Machine
@ : At the rate of

A/C : Account

A/D : Acknowledgement Due
A/S : Account Sales

B

BASIC : Beginners All Purpose Symbolic Instruction Code
BPO : Business Process Outsourcing
B/E : Bill of Exchange

B/L : Bill of Lading

B/S : Balance Sheet

B2B : Business to Business

B2C : Business to Consumer

C

CA : Chartered Accountant

CAT : Common Admission Test
CAD : Computer Aided Design
CENTREX : Central Exchange

CEO : Chief Executive Officer
COBOL : Common Business Oriented Language
COD : Cash on Delivery

Corp. : Corporation

CPM : Critical Path Method

CR : Confidential Report

C/IA : Current Account

CVv : Curriculum Vitae

C2B : Consumer to Business

c2C X Consumer to Consumer

D

DA : Dearness Allowance

DD : Demand Draft

Disc. : Discount

DLO : Dead Letter Office

DSC : Digital Signature Certificate
DVD : Digital Versatile Disk
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D/A : Documents against Acceptance

D/P : Document against Payment
E

E-Commerce : Electronic Commerce

EOQ : Economic Order Quantity
EDI : Electronic Data Interchange
EDP : Electronic Data Processing
EMI : Equated Monthly Installment
ENCLS : Enclosures

Etc. : Et cetera (And other things)
E&OE : Errors and Omissions Excepted
e.g X Exempli gratia

E

FAQ : Frequently Asked Questions
FAX : Facsimile

FDI : Foreign Direct Investment
FIFO : First in First out

FIR : First Information Report
FOB : Free on Board

FOR X Free on Roil

FT Calls : Fin Time Calls

FYA X For Your Action

FYI : For Your Information

G

GPO : General Post Office

GST : Goods and Services Tax

H

HQ : Head Quarters

HR : Human Resource

HRD : Human Resource Department
1

Intercom : Inter Communication System
IOU : | Owe You

IRCTC : Indian Railway Catering and Tourism Corporation
ISD : International Subscriber Dialing
ISP X Internet Service Provider
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IST : Indian Standard Time

ITD : Income Tax Department

1/0 : Input-Output

i.e. : Id est (In other words/that is)

J

JIT : Just in time

K

KPI : Key Performance Indicators

L

LC : Letter of Credit

LIC : Life Insurance Corporation
LIFO : Last in First Out

LLC : Limited Liability Company
LTC : Leave Travel Concession

Ltd : Limited Company

M

MIS : Management Information System
MNC : Multinational Company
MOOC : Massive Open Online Course
MOU : Memorandum of Understanding
MRP : Maximum Retail Price

N

NGO : Non-Governmental Organization
NOC : No Objection Certificate

NOI : Net Operating Income

NRN : No Reply Necessary

(0)

QC : Quality Control

O&M : Organization and Methods

P

PABX : Private Automatic Branch Exchange
PAN : Permanent Account Number
PAYE : Pay As You Earn (tax)

90



PC : Personal Computer

PCO : Public Call Office

PNR : Passenger Name Record
POD : Payment on Delivery

PR : Public Relations

PRO : Public Relation Officer

PS : Post Script

P.A : Personal Assistant

P.P : Particular Person Call

P.S : Personal Secretary

P&T : Post and Telegraph Department
P/N : Promissory Note

p.a : Per Annum

Q

QMS : Quick Mail Service

R

RAC : Reserve against Cancellation
RAM : Random Access Memory
RBI : Reserve Bank of India

RTI X Right to Information

R/R : Railway Receipt

R&D : Research & Development

S

SLA : Service Level Agreement
SP : Superintendent of Police
SQC : Statistical Quality Control
STD : Subscribers Trunk Dialing
I

TELEX : Teleprinter Exchange

TMO : Telegraphic Money Order
TIN : Taxpayer Identification Number
V]

UPC : Under Postal Certificate
UPSC : Union Public Service Commission
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VAT
VIP
VPP

WWW
Ww.r.t

Value-Added Tax
Very Important Person
Value Payable Parcel

World Wide Web
With Respect To
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